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Chapter 1. About cardPresso

cardPresso is always deweloping cutting edge ID Card solutions. Our team has R&D technologies
and ID software development skills for many years and the result of our efforts is the Next Generation
Plastic Card Software - cardPresso, created in 2012.

Our programmers have used the most recent innovations from different fields of information and ID
security technologies. Our goal is to create the perfect balance of functionality and usability, while
ensuring end users ease in using our software. We're constantly exceeding our goals through the
team efforts of our developers, analysts, resellers and our most important contributors our clients.

1.1 Overview

Welcome to cardPresso.
cardPresso is more than an application...

Why? Well cardPresso is not only a very simple software, but also powerful and user friendly
software. Is also a dedicated and experienced team of professionals, support experts, software
development innovators and sales specialists, including our distributors that provides you the best
software solution on the market.

cardPresso is committed to a continuous software improvement by being responsive to clients
requests, keeping in touch with new technologies and anticipating the needs of an ever-changing
plastic card industry. Our worldwide staff is available to assist you as needed through training,
technical support, sales information or through a wide range of senices including full software
customization, stand alone projects or embedded projects, headed or followed by cardPresso.

cardPresso allows you to create a card from scratch to production, without any outsource program
to deal with any aspect of the card creation process, like image treatment or card encoding and even
the database connection issue, because cardPresso can connect to any database.

cardPresso's capability of working on Mac and Windows Operating Systems have been the market
revolution, satisfying both end-users. This have been not only a challenge but also a commitment
that allows cardPresso to work with a world wide range of clients.

Whether it's automating routine tasks or solving your toughest IT challenges, cardPresso delivers
rapid value and simplifies the plastic card creation process management, across physical, virtual and
cloud environments. And that means less chaos and stress for you, plus big cost-savings for your
organization.

1.2 Features

= Software Box and Installation

cardPresso comes with a full setup on an USB key that allows you to work in any PC or Mac and
carry your work with you. It also brings a Digital Manual in PDF, card templates, clipart and shapes
and allows a group and user log-in management.

» Tools & Image

cardPresso have on it's tools a strong hold to its users, like 1D and 2D barcodes, variable objects,
templates, text setup, full image acquisition, face detection and a complete built-in image editor.
You also have access to a multi-layout design option.

© 2013 cardPresso
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= User Interface

cardPresso have essentially five different views:

- the Welcome View where you define how yo start or resume a previous card creation process,

- the Users View where you can define groups and user log-in management,

- the Document View that gives you a complete oveniew of the document and at the same time
allows you to work directly on the card design,

- the Database View that is a full manipulation tool,

- and finally the encode view where you can setup your card encoding.

* Print
cardPresso offers a front and back print option, SDK driver printing, ethernet printer support, overlay
panel management and in some editions batch printing, print status and conditional printing over
database.

= Database

cardPresso allows you to connect to any kind of database, CSV, Excel, SQL, txt, Oracle, among
others. Also brings an internal database with photo connection and a powerful database tool set
where you can create and edit a database, link an image to a field, browse and find records and
concatenation options.

= Encoding

This feature allows magnetic encoding, contact smartcard plugin, contact smartcard encoding,
contactless RFID encoding and internal / external RFID encoding. Also has a internal / external RFID
encoder support.

» Miscellaneous

cardPresso gives you free updates and automatic edition upgrades.

A user log that permits a step-by-step follow up of your work.

And a programming script (JavaScript, based on ECMEAScript Language Specification).

1.3 Security

cardPresso team has opted for an USB pen solution that comes with a full setup.

Why? Because through this pen you can work in any PC or Mac with the advantage to carry your
work with you and also because it makes easier to recover your license online through cardPresso.

This is a 4GB pen, that means that a lot of work can be carried on it. With the benefit of no one
touch your card files, images, databases, or whatever you need to carry with you.

© 2013 cardPresso



Chapter 1. About cardPresso n

Currently there is a cardPresso XL Edition license on your
computer, click here to check for registered upgrades for
this license

SN:CP-0701-0B03-017E

|Check for Upgrades

| Close

B Advice: Always make a copy of your work. All data on your pen is recoverable except your work.
A pen is a piece of hardware as reliable as any other.

© 2013 cardPresso
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Chapter 2. Installation and Support

cardPresso is easy to install and customize.

2.1 Installing cardPresso

For Windows and Mac installation, please follow the steps cowered on the the topics Windows
Installation and Mac OS Xlnstallation.

2.1.1 Windows Installation

Welcome
Plug the provided USB key on one of your available USB ports. The AutoPlay will run automatically
and choose the 'Open older to view files' option.

Double-click on the cardPresso executable file and the Installation Wizard will run. The Installation
Wizard is displayed where you can verify the Serial Number of your product and also select the
language to install. To proceed with the installation click the 'Next' button.

Install
This wizard helps you to install cardPresso
Serial Number CP-0701-0B03-017E

Shortcuts
Finish

Please select language to install

English -

CARIPRESSO

mare than an application

Install or Evaluate
Select the installation folder. By default cardPresso software is installed on the Programs Folder but
you can select another destination folder by selecting the 'Select Destination folder' option.

Check the option 'Install for all users' if you want other Windows users to also run cardPresso
software. Click 'Next' to continue.

If you want to run the application without installing it please click 'Evaluate'.

© 2013 cardPresso
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Welcome

Please select the installation folder or click on 'Evaluate’ to run
cardPresso without installation
Shortcuts Install in Programs folder

Finish W Select destination folder
Install for all user

CARIPRESSO

more than an application

Shortcuts

Check the shortcuts that you want to create for easy access to the application, and if you wish to
open card files immediately with cardPresso select the file associations checkbox. Click 'Next' to
continue.

Welcome

This wizard can create shortcuts for easy access to cardPresso.
Select the check boxes below to create the corresponding
shortcuts

Install

- Create programs shortcut
Finish S
Create desktop shortcut

Create Start Menu shortcut

Create cardPresso file associations

CARIPRESSO

more than an application

Finish

Click 'Finish' to install cardPresso software.
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Welcome
cardPresso 1.1.23 XL Edition
Serial Number CP-0701-0B03-017E

Install

Shortcuts
B Delete the wizard file after installation

CARIPRESSO

more than an a tion

2.1.2 Mac OS X Installation

= |Install
Plug the USB key and double click on USB drive icon, then double-click on the cardPresso.dmg file
and the end user license agreement appears, click 'Agree' in order to proceed.

cardpressol.1.14.0sx10.6.dmg

IMPORTANT - Read this
License Agreement carefully
befare clicking on the END-USER LICENSE AGREEMENT FOR "cardPresso”,
“Agree" button. By clicking COMPANY LICENSE"

on the "Agree” button, you
agree to be bound by the

terms of the License IMPORTANT - READ CAREFULLY

Agreement.

Please read the following license agreement. You
must agree to its terms before using this software.

This end-user license agreement ("EULA") is a legal
agreement between you either as an individual or a
single entity ("LICENSEE") and cardPresso Lda. for
cardPresso, including computer software, electronic
documentation and printed materials ("SOFTWARE").
By downloading, installing, copying, or otherwise
using the SOFTWARE, you agree to be bound by the
terms of this agreement. If you do not agree to the
terms of this EULA, oromptly destrov all copies of the

Print Save... Disagree Agree

Now drag and Drop the cardPresso icon into the Applications folder alias to install.
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000 |= cardPresso 1.1

CARIPRESSO

1 appl

For Mac OSX 10.6+

2.2 Changing Language

You can change the language of the user interface at any time.

To change the language of the cardPresso software, click "CP" -> Language. Choose the desired

language from the list and restart the application to apply the new language settings.

Eﬂfile Edit wiew Tool Wndow

About cardPresso Arabic
Zesky (Czech)
Clear Config Danish
USE Devices Deutsch (German)
v English

Update Security

) Espafiol {Spanish)
View Folders

Frangais (Francese)

Printer Drivers Indonesia {Indonesian)
Language 4 Italiano (talian)
BFIE (Japanese)
fh=t] (Korean)

Mederlands (Dutch)

Norwegian

Polski {Polish)

Portugués (Portuguese)
Eyccwwi (Russian)

Sloventina (Slovak)

Swenska (Swedish)

Tiéng Viét (Vietnamese)
YIRAPIER (Traditional Chinese)

2.3 Updating cardPresso

We advise to keep always your cardPresso software updated. In order to do so please go to https://
www.cardpresso.com'&gt;www.cardpresso.com website and download the setup required for

your operating system.
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| CARIPRESSO

VIDEO TUTORIALS

INSUPPORT /VIDEO TUTORIALS OR
YOUTUBE.COM/USER/CARDPRESSO
SEEHOW WITHOLR VIDEO TUTORIALS.
NEW VIDEOS EVERY WEEK

MAILABLE ror B Windows W

|

V.. —" 970000

FOR WINDOWS (ZIP FILE) m

£7 DOWNLOAD 2] DOWNLOAD  (  DOWNLOAD  You[ff[j- CHANNEL

1.1.15 = for Window 1.1.15* Zip File 2144 * for Ma

2.4 cardPresso Support

For cardPresso’s team the most important is the relationship with our costumers, keeping it as
closest and personal as possible. For these reasons, we are committed to offer you the best
support.

We can offer support by phone, email, Skype or remote sessions (TeamViewer):

=
(=]

00351 261 867 873

4
support@cardpresso.com

>

cardpresso.support

2.5 Installing Complete Manual

If you want to use the embedded manual on cardPresso software, with a dynamic index and search
capabilities, please download the "cardPresso.cph” file, and sawe it to your cardPresso USB pen
folder "\cardPresso\Documentation\HelpFiles".

If you don't hawe this directory on your USB pen, please create it.

© 2013 cardPresso
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Chapter 3. Starting

O mis chapter explains how to handle a document, model or template, how to create or open an
existing file and also how to recover a backup file.

Document - Contains all data related to your work, including chosen model or template, all objects,
database connections, properties, encoding properties. In sum, all the properties involved in your
card document creation.

Model - Contains all the features and shape of your physical card. These features are size and card
type, if is a basic card, a contactless, magnetic or smartcard. Please notice that the card settings
depends on your chosen or created model type. For instance, you can't access the chip encoding
settings if you've chosen or created a card without SmartCard capabilities.

Template - Is no more then a pre-made document layout used to create a new document with a
similar design, pattern, or style. This means that you can use an existing template as it is or you
can use an existing template and change it as you wish, creating a new document or template from
the opened template.

Backup - cardPresso automatically generates a backup file of your document every time it's saved.
This backup is created on a pre-defined folder (\My cardPressoDocs\Backups') with the document
name and date/time creation.

O This document can be recovered any time you need.
Exemple: documentname(yyyymmddThhmmss).cardBackup

3.1 - Using Models

© cardPresso allows you to create a document in two different ways, by using an existing model
or by creating your own card model.

The first one only requires you to choose one of the many different type of models that cardPresso
have at your disposal. Like mentioned before, you have four major kinds of card models: basic,
contactless, contact smart card and magnetic, and each type can hawe different settings like sizes,
different kinds of magnetic strips and so on, all listed on cardPresso model type.

But if you have one specific type of card model that is not listed, cardPresso allows you to create it
and that's the other way to create a document, using a new card model.

O Note that whatever model you choose, it will restrict access to further settings and properties,
like referred before. If you open a "Contact Smart Card", the result will be a model of your "Contact
Smart Card", where you can only edit Smart Card Settings, and it will no allow you to access, for
instance, RFID settings.

3.1.1 - Create from Existing Model

O mis topic guides you on how to create a new document using an existing model. You can start
a creation procedure by clicking on the create button on the "Welcome View".

0 'Welcome View' » 'Click Create’

© 2013 cardPresso
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Or o '‘Click File' menu » 'New' ( CRTL+N )

cP m Window Help

[ New Ctrl+M
£ Open Template Ctril+shift+0
£ Open Cirl+0

Exit

© Then choose the type of model you want. The model types are organized in 8 groups:

E Unusual, set of models used by a small number of users. Model types developed for specific
projects are now included on this group.

E Magnetic this model type allows you to encode the magnetic stripe through cardPresso. This
means that you can print and encode your card at the same time or use an external encoder. This
cards may contain secondary technology, like RFID technology.

™ Contactless card is any pocket-sized card with embedded integrated circuits that can process
and store data, and communicate with a terminal via radio waves. This type of card model allows you
to encode through cardPresso. By using Javascript language, you can program your card and
perform read and write operation on the card. This also means that you can print and encode your
card at the same time or use an external encoder.

™ Mifare, this card model, when chosen, allows you to read or write the several sectors of your
card. By using Javascript language you can connect the sectors to database fields and update them
automatically or simply enter data through keyboard input, therefore you can print and encode at the
same time. This cards may contain secondary technology, like Magnetic stripes.

™ Contact, a smart card, chip card, or integrated circuit card (ICC) is any pocket-sized card with
embedded integrated circuits. In cardPresso you have three types of card models, JCOP (Java
Card), SLE4442 and generic. This type of card model allows you to encode through cardPresso. By
using Javascript language, you can program your card and perform read and write operation on the
card. This also means that you can print and encode your card at the same time or use an external
encoder.

Ef Basic card models, have no contacts, no micro processors or internal memory. Simple piece of
plastic that you can print in front and back side.

© 2013 cardPresso
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E Common card types, are the most common types of card models, used by the vast majority of
users.

™ My Models, if you have any models in folder "My Models", they will become available in this
group.

card TYpes 16 Card Types | All Card Types

i
My Models

F F 1 Magnetic

CR80 90X58 ’))) GEN Eﬂ?f;E:Ctless
s Contact

Basic
Common Card Types

I
i))) MIFARE |ﬂ| SLE4442

r» HEE r-
kA ko
il LW )

OK. Close

After you have choose the model type, 0 'Click OK' and you will be able to start working on your

new card. Or o 'Click Close' if you want to revert to the previous window.
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& cp Fle Edit view Tool Database Window Help [BEE

EEEEE OcaE AAA B

mm

EFBEEEERE-ONN G

61 Backgrounds found, 0 folders remaining

e For your first card design, please watch the video tutorial Create a Business Card, see also the
Objects and Properties topic.

3.1.2 - Create Your Own Model

(i ] To create a document using a new model, you hawe to start by creating the model. This will be
your starting point to customize your own document.

Card Types 4 Card Types

)))) GENERIC )))) MIFARE

oK Close

Your next step is to rename that same model with a new file extension, '.cardModel' and sawe it on
cardPresso folder called "My Documents/My Models" in order to be identified as a model.

1] It is important that you save your file in the folder "My Models", to be displayed in the category
"My Models" in "Select model type".

Q Click File » Save or Save as and create your file as the example below, in your folder "My

Documents" (To see this folder locations, please click on menu o CP » View Folders)

© 2013 cardPresso
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File name: your_card_model.cardModel

-

Save as type: | card (*.card)

)

* Browse Folders

[ Save

) |

Cancel l

Ay
& Your file must be saved with the extension .cardModel

O At this point, you've created your new model "yourdoc.cardModel." The next step will be to

locate your file and open it.

0 Click File » Open » Explorer » cardPresso Favorites » My Cards » | =*=

Explorer|

4 |5 cardPresso Favorites
. My Recent Cards
. My Cards

Sort Cards By [name

IPRESSO El
> (& My Computer 3 Cal’d(s)
oK ‘ Close
Organize « Mew folder == .@.
MName Date modified Type Size
=] your_card_model.cardModel cardPresso Model 3KB
File name: your_card_model.cardModeIl - ’cardModel (*.cardModel) vl
[ Open |vl ’ Cancel l

0 Select the file extension in the corresponding combo box, otherwise your file will not be listed.

O After opening the model, you can customize the dimensions and corners radius. On your
right on the properties tabs you will find a tab named "Layout" where you can change the card

dimensions and corners radius,

© 2013 cardPresso
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3 width  [85.725 mm =
-

B Height [53.975 mm 2

RX [2 mm }é{

Y

RY [2 mm

"

Background

=
]
0

]

Layouts

You can also change the orientation of your card by Q clicking on File menu » Configure Print

and In "Print Layout” o Click Orientation and select your card orientation. The card orientation
can be changed at any time, but this will be your card default orientation.

Orientation [ | Landscape -

_| Portrait

€ You can add images, text or other elements to customize the thumbnail that you will see in the
preview area.

Your Logo

My Model 85X55mm

6 The last step is to save the model that you've just created. From now on the new model will be
displayed in the Create Document Dialog Box, under the category "My Models".

O Click File » Save (CRTL+S).
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Card Types 1 Card Types | My Models -]
E
g
Your Logo
E
[ ok || close

3.2 - Using Templates

(i ] A template is a collection of styles that control the layout and appearance of a card document.
You can quickly create your card document using one of our many templates.

cardPresso provides these templates organized in categories, such as Test and diagnostic; Sports;
Shopping; Schools; Loyalty; Clubs & Resorts; Business; Activities and Access Control.

But if for some reason this categories don't fit your needs, you can always create new ones, just go
to My Templates directory and once there create a new folder and cardPresso will assume that
folder to be a template category.

The Templates covers a wide range of graphics and variable field types, all of them fully editable.
These professional templates are part of your cardPresso software. You cardPresso USB pen also
contains additional templates.

[AH Card Templates v

All Card Templates
TestAndDiagnostic
Sports

Shopping

Schools

Loyalty
Clubs&PResorts
A Fr Bus_\r_iess
; o 8, Activities
) Kids Park @ AccessControl
€4
i

o

L

e\g",;, .
e

Chess Master C

H
3

TS B
5 Sonka

XTREME

= e are

CZHS Il"l"""l""m SEUPRESIESE ¢ MALL DISCOUNT CARD * géy
' : Taanizs I ATARRY R " 2 B
OK Close |
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3.2.1 - Create from Existing Template

6 To create a document from a template, in Welcome View o Click Template

r —
| 2 () r‘
G i =
CREATE USERS QuIT

o Click File menu » Open Template ( CRTL+SHIFT + O)

CP BEIEN Window Help

= New Ctrl+N
& Open Template Ctrl+Shift+0
B Open ctrl+0
L}
Exit

TestAndDiagnostic
Sports

Shopping
Schools
Loyalty
Clubsé&Resorts
Business
Activities
AccessControl

Chess Master C

i
THE MALL DISCOUNT CARD "_F‘ i ?’
TR H
- - - - e k-‘- E

oK Close
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— In the dialog box, search thru the available templates.

6 You can create a card based on a template and then modify the document without affecting the
original template

B cp Fle Edit View Tool Database Window Help =]

I@Eﬁ E:».EI &&& ic}ﬁaé 3-3153535 = sl €

mm

Font Family

[Anal \']

Point Size

[21.0pt [4 0 Ao
olor

Position | Item

Typeface

B L U

.'_- O wvord wrap

| Enter J‘f.xt

Ohlo 'l[ennl club

Source (WM Fil | outlin

AP EEO~"ONN F |

e By making changes to the background, images, text, and orientation card. You can create a new
design to suit your needs. You can also modify any card object in your document.

6 All you have to do now is to save your new card document.

3.2.2 - Create Your Own Templates

6 If the preset templates do not meet your requirements, you can create a template based on your
own styles.

To create your own template, start by creating a new card and chose a model type that fits your
need. For instance, if you chose for example a contactless model, the result will be a template
based on your contactless, but with your own design.

Card Types 4 Card Types

)))) GENERIC }))) MIFARE

oK Close

0 Click 'OK'. If you want to continue. Otherwise click 'Close’ to revert to the previous window.
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i YN template may include any object type, variable field or text that can be edited and modified at
any time. Make all the changes you want on your template and then sawe it with 'cardTemplate' file
extensione, on the appropriate folder in cardPresso (.../My Cards/My Templates/...).

After you've completed the design for your new template, save it using .cardTemplate' as the file

extension.

0 Click File » Save or Save as and create your file.

File name: your_card_template.cardTemplate

Save as type: | card (*.card)

| s )| cance |

* Browse Folders

Ay
#" Your file should have the extension .cardTemplate
© You can edit your template at any time.

0 Click File » Open » Explorer | ===

Explorer .. _ Sort Cards By [name
4 |z cardPresso Favorites -

e .
ey computer 3 Card(s)

OK 1( Close .
Organize + Mew folder == -« [ @&
Marme z Date modified Type Size
3KB

= your_card_termnplate.card Template

File name: your_card_template.cardTemplate ~ [cardTempIate (*.cardTemplate) v‘

[ open |+) [ cance |

O sclect the file extension ".cardTemplate" in the corresponding Combo Box, otherwise the
template files will not be listed.

O After you have completed your template edition Q click Save and your old template will be
replaced with the new modifications.
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3.3 - Open Your Own Card Documents

© In cardPresso there are two kinds of files, the ones you create, called card documents and the
ones created by cardPresso designated by backup files.

To better organize your documents, in the "Open Card" window, you find "cardPresso Favorites"
with two folders - "My Recent Cards" and "My Cards". Or alternatively you may locate your file in
another folder in "My Computer".

You can sort the way how the cards are displayed. You may sort them by Name, Name
Descending, Modification Time, Modification Time Descending and File Size Descending.

Explorer| .. Sort Cards By | Madification Time

4 (=) cardPresso Favorites
My Recent Cards
My Cards

> | My Computer

IPRESSO

Number of cards or name of your card

oK Close

O In the lower right corner you can find the information about how many readable documents are
currently present in the selected folder, or the name for the current selected card document.

3.3.1 - Open a Existing Card Documents

© voucan open an existing card document to edit, change or even print again. The existing card
always keeps the last saved properties.

The first step will be to locate the document card that you wish to open. In order to do so please
click the 'Open' button on the "Welcome View" or use the 'Open' option from the 'File' menu.

0 Click File » Open ( CRTL + O ) » Explorer and locate your card with extension .card

Explorer| . Sort Cards By |name
4 [=) cardPresso Favorites 5
' K . JPRESSO -
ey Computer 3 Card(s)
OK Close
Q ciick ok.
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Organize « Mew folder 0l @
Marne : Date modified Type Size
Backups File folder
My Models File folder
[&| my_card.card cardPresso Docu... 04 KB
File name:  rmy_card.card - Icard (*.card) v|
[ Open |vJ | Cancel |

Ay
& Your file should have the extension .card

—Also remember that you can open the file directly from Windows by double clicking on on it
inside Windows Explorer.

O Sselect the file extension in the corresponding Combo Box, otherwise your file will not be listed.
To proceed "Open".

3.3.2 -Recover Your Card Documents From Backups

i I backup is a file that cardPresso automatically creates every time you save a document in a
internal or external drive. The file will be saved with a date and time reference to make easier to
detect the last backup made. Like this you have the assurance that you have a copy of your
document in a specific date/time, in the backups folder.

Before opening your backup, you should know where cardPresso created the backup folder during
installation. To check the path:

O Ciick CP » View Folders

cardPresso Folders,

BACKGROU... $PENS$/cardPresso/ClipartFiles/Backgrounds
BACKUPS C:/Users/Daniel/Documents/My Cards/Backups
CLIPART $PENS$/cardPressa/ClipartFiles/Clipart
COMPONENTS C:/Program Files/cardPresso/COMPONENTS
DATABASE C:/ProgramData/cardPresso/DATABASE
DOCUMENTS  C:/Users/Daniel/Documents/My Cards

MODELS $PEN$/cardPresso/CardFiles/Models

MYMODELS C:/Users/Daniel/Documents/My Cards/My Models
PICTURES C:j/Users/Public/Pictures/cardPresso

PRINT C:,iDmgramData,icardPresso,‘PRlNT
PRINTSETTIN... C:/ProgramData/cardPresso/PRINTSETTINGS
SHAPES $PENS/cardPresso/ClipartFiles/Shapes
TEMPLATES $PENS$/cardPresso/CardFiles/Templates

USERS C:.ingramData.i:ardPresso,‘USERS

TRANSLATIO... C:/Users/Daniel/Documents/Translations

Close

O Now that you know where your backups are stored (.../users/.../Documents/My Cards/
Backups ), you can easily locate the backup document that you need to recowver.

Q Click File » Open » Explorer » cardPresso Favorites » My Cards » 2= » Backups and
select your backup document in the folder "Backups"
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0 Remember that your backup has a 'filename(savedate Tsavetime).cardBakup' filename

convention.

Explorer| ..

4 |z cardPresso Favorites
| My Recent Cards
. My Cards

> | My Computer

Sort Cards By |name

JPRESSO ¥

3 Card(s)

O ciick ok.
Organize « MNew folder =~ [0 @
Name ’ Date modified Type Size
|| daniel(20130111T124839). cardBackup 08-01-2013 16:21 cardPresso Backup 94 KB
=] My_Model(20130110T215857).cardBackup ~ 10-01-2013 21:54 cardPresso Backup 3KB
=] My_Model(20130110T220933).cardBackup ~ 10-01-2013 21:58 cardPresso Backup 6 KB
=] My_Model(20130110T221047).cardBackup ~ 10-01-2013 22:09 cardPresso Backup TKB
=] My_Medel(20130110T221135).cardBackup  10-01-2013 22:10 cardPresso Backup 3 KB
=] My_Model(20130110T221327).cardBackup ~ 10-01-2013 22:11 cardPresso Backup 8 KB
=] My_Model(20130110T221350).cardBackup ~ 10-01-2013 22:13 cardPresso Backup 8KB
|| My_Meodel(20130110T221406) cardBackup  10-01-2013 22:13 cardPresso Backup 3 KB
=] MyModel(20130110T170818).cardBackup 10-01-201317:06 cardPresso Backup 83 KB
=] MyModel(20130110T172244).cardBackup 10-01-2013 17:08 cardPresso Backup 5KB
File name:  My_Model(20130110T215857).carc + [cardBackUp (*.cardBackup) v]
[ Open |v] [ Cancel ]

Ay
& Your file should have the extension .cardBackup

eNow all you hawe to do is to save your document with another name and with .card extension.

! ] Select the correct file extension in the corresponding Combo Box, otherwise your file will no be

listed.
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Chapter 4. Design

© The definition of design is the creation of a plan or convention for the construction of an object
(as in architectural blueprints, engineering drawing, business process, circuit diagrams and sewing
patterns). Design has different connotations in different fields. In some cases the direct construction
of an object (as in pottery, engineering, management, cowboy coding and graphic design) is also
considered to be design.

Well, in cardPresso you can also design and when you design you build a layout. To accomplish
this, cardPresso provides the user with specific tools and objects, allowing you to build your layout
according to your imagination, capabilities and needs.

0 As you know, when you design you create a file, called document, this document keeps inside
all settings you will use on your creation.

4.1 - Workspace

© In cardPresso you can customize your working area as you wish. You can reposition the menu
bars or you can view or hide properties areas.

0 On the View menu you have a set of options that allows you to change your working scenario.

ToolBars

Ef Here you can select all the dockbars that should be available in the working space.

CP FHle Edit_Tqu Database window Help

s | View Card Front

— View Card Back

v Document Properties

4
ToolBars v Document Toolbar
Zoom ¢ v Views ToolBar
) v Zoom Toolbar
Metrics 3
v Database ToolBar

Bulers 3 I

) v Design ToolBar
Grid 3 9
Workspace Color » Use defaults

- ——————

Metrics

E Allows you to define the measurement unit that you wish to work with.
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CP Hle Edit Tool Database Window Help

£ View Card Front

= View Card Back

v Document Properties

ToolBars 4
Zoom ’

: b -
Metncs v Millimetres
Rulers ’

Inches
Grid 4
workspace Color »

Rulers
Ef Visible - Show or hide the rules in the card design area.

E Selected Items - Shows or hide the area occupied by selected items on top of the card design
rulers Set

CP  File Edit'_l'm}l Database Window Help

= View Card Front

= View Card Back

v Document Properties

ToolBars ’
Zoom »
Metrics 4
[ -

Rulers v Visible

: 3
Grid v Selected ltems
Workspace Color ’ i

v Page guides

Grid
E Visible - Set the card visible or hidden

E Snap to Grid - Allows you to move and/or position the objects on a grid unit step or free move
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CP  File Edit]’uul Database Wndow Help
r

= View Card Front

— View Card Back

v Document Properties

ToolBars 3

Zoom 2

Metrics 3

Bulers 3

i 3 .
Grid Visible
3 .

Workspace Color Snap to Grid

Workspace Color

Ef Allow you to chose the workspace background color

CP Fle Edit Tool Database Window Help

= View Card Front

= View Card Back

v Document Properties

ToolBars 3
£ 4
——— Black
Metrics 3 Elue
Bulers 3 Gray
Grid 3 white
Workspace Color k| v cardPresso

Custom

Choose Custom Color

. _____________________________________

© Switch between front or back card side.
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cP Fle Edit View Tool Database ‘Wndow Help

mEEE= B

[ 1

fooooloonn Tooooloonolooos

3)

h |
3 p—
. R A N - —
€1 history records

e brow=- "~ qe

S0CCERscHooL

WHLLY0 URSOCCERSCHOOL.COM

© Switch to Database View.
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CP FEle View Database Window Help

EEEEs U@ AR &

Browse Records

Database
C:/ProgramData/cardPresso/DATABASEfinternalDatabase.mdb, Table:Employee
Record 1 of 15 2
i
- _
Employee Id Supervisor Id Last Name First Name e E SOCCERsHooL
1 5 Davolio Sonia Sal L
B2 Fuller Andrew Vice a
B3 5 Leverling Janet Sales
4 s Peacock Margaret Sales
s 2 Buchanan Steven Sales
F6 5 Suyama Michael Sales
=7 5 King Robert Sale: ‘ Front ‘ Back
(mE:] 5 Callahan Laura Inside .
(=] 5 Dodsworth Anne Sales
10 2 Hellstern Albert Busin
L n Smith Tim Mail

|Se|ect Al |Select None | Toggle Selection

Database Record

Database C:/ProgramData/cardPresso/DATABASE/internalDatabase.mdb, Table:Employee
Record 1 of 15

Employee Id H Photo

@ Supervisor Id

Last Name

& = [pavalin | I \IlB . .

= I | L]

©® Sswitch to Encoding View.
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CP Ele View Database Window Help

(= [~ . = ) 3 | @
EEEE N LSEE ARN

ENCODE DATA ENCODE OPERATIONS

%)
I

(e
®

(a1
&
O
(1
Gt

1

B

SOCCERSscHooL

k:

| Front | Back

Output @]

DATA INSPECTOR

BLOCK HEXADECIMAL ASCIl

cript | Database Find | Database | User Data | Printer Tools ( Preview I é

S

Continuos Read

il

q | i

4.2 - Document Properties

© When you open the document view, the first thing you will see is the work space and on the right
right side the basic properties of your card document.

K Layouts - Like we said before on this manual, when you design a card, you are building a layout
and on cardPresso, a document can have as many layouts as you want. The Layouts Tab is our
way to offer you a quick way to manage all the possible layouts on your card document.

E Backgrounds - Each layout can have an unique background. You can access cardPresso
backgrounds library using the Backgrounds Tab. To apply a background just select it from the list
and the background will be applied immediately to your card layout. You can also set the
background using an image object.

™ Clipart - You can access it using the Clipart Tab. They can be used as an image object, part of
your card layout creation, or as a background. Please note that you can only change the
background color of the object.

Ef Script - The Script Tab allows you to write your own script commands, based on the
ECMEAScript language specifications. This is a way to extend the already large number of features
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that cardPresso offers you. It also allows you to interact with external software, using the results to
apply on your document. You have three different kind of script boards, one for each object, one for
the card document and one for encoding, three different ways to expand cardPresso capabilities.

4.2.1 - Background

(i ] An image to be applied as the background of your card. cardPresso offers you many
background images that can be used from landscape cards to portrait cards.

lAII classes

Background

lipart

n
=
S
o
>
]
|

61 Background

s found, 0 folders remaining

Background

Clipart

Layouts

[AII classes

11 Backgrounds found, O folders remaining

0 Background are divided in classes that are accessible through the background combobox.

[AII classes

All classes

Technology
Transportations
Unsorted
Geography
Foad
Shopping
Celebration
Animals
Architecture
Buildings
Cats

Dogs

Clean

Clown
Computers
Couple
Cycling

lce

lce cream
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6 It's also possible to use your own image as the card background. Next, we will explain you how.

Add an image object to your layout, then right click on the object and chose 'Set as a Background'
option, like shown on the picture bellow.

CPF Fle Edit View Jool Database Window Help

REESa® Do8E AAKN & o
T i e o 09 aoTine e 000 ka0 00 i a0 3¢ d ke at o0 a0 Al e ateng o ecenacor orgn

EeREREEEBRE- =00 B

=

Delete

Duplicate

m Send To Front
& Send T Back

Ctri+C
Del
Ctri+D

C

| Background |

Export Image

[ Set As Background

Fit to Card

Backgrounds faund, O folders remaining

If you want to change or edit the background, right click on the card and choose o 'Edit

background'.
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HEEE teem ARA @

Select all

L
-

Duplicate
Paste

[ Edit Background

1063 x 709 - 100.0

The Image Editor will open and from there you can edit the background image. To commit changes,

o click on the 'Save Changes' button, otherwise press 'Cancel' to continue.

4.2.2 - Clipart

6 Clipart are pre-made images that can be used to help on the layout creation. cardPresso offers
you

E [Allclasses |"]
o
| E
II]'%
|
@ e |
= e
0= @
IS,
1282 Images found, 0 folders remaining
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0 They are divided in classes. All you have to do is select one class from the dropdown combobox.

[ All classes

All classes

Symbols
meats_and_eggs
thanksgiving
Nautical
Celebration
Clock
Countries
Flags

G10
Geography
Bread
Burguer
Food

Hot Dog
Peripherals
Storage
Vegetables
dairy
Dolphin
Dunk
Elephant
Grass Hopper
Gull

=
c
=]
2
]
[=]
]
m

Layouts

(i ] Select the image from the clipart list, and drag it to the card design area. The selected image will
be used as an image object that you can modify.

All classes

& =

&

9%

He lAE
el -

[
ﬁ,
|

)
S
O
-
F 3
/

1282 Images found, 0 folders remaining

N\ B M

e
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4.2.3 - Layouts

(i ] The Layout Tab allows to define properties, settings and conditions for the use of the layouts.
This feature allows you to use on the same card document as many layouts as you need and
conditionally print the ones you want.

Background

|Lay0ut 2 |

Clipart TEack:gr ind

|Lay0ut 2 |

=
o
o

']

I

[ Add J [ Copy J I Delete I
Auto Select based on database condition

[ Add II Copy H Delete ]

[ Employee ID |+ ]

[ Is Equal |v]

[J Auto select on card design

w
)
3
o
=
o
—
e
@
wn
o
Eal
o
i}
Eﬁ
O
p—
=
C
T
QT
wn
o
O
m
a
Eﬁ
O
W
4+
0o
G

B/

=]

Ef Name - You can give a name to your layout.

[M Add - You can add a new empty layout.

Ef Copy - Creates a new layout based on the current selected layout..
M Delete - Delete the selected layout.

Ef Auto Select Based on Database Condition - When checked it allows access to a condition
box, where you can define fields and conditions for every layout. Remember that these conditions
are restricted to the selected layout.

6 After you enable the checkbox, the first drop list shows all the available fields from the
connected database. You can apply conditions based on the available fields as you can see below.
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[ Employee ID

Employee ID

Supervisor ID
Last Name .
First Name

Position
Birth Date
Hire Date
Add Copy Delete Home Phone
Extension
Photo

[ MNotes
I
_Emplnyee D . J Reports To

Is Equal . Salary
. SSN

(1234 ‘. ) ||Emergency Contact First Name

[ Auto select on card design Emergency Contact Last Name
Emergency Contact Relationship
Emergency Contact Phone

Layout 2

.m Background

¥ Auto Select based on database condition

Layouts

[ Is Equal

Is Equal

Is Not Equal
Contains .
Mot Contains

Is Null
Is Not Null

E Is Equal - Link the chosen layout to all records with the selected field equal to the input value.

E Is Not Equal - Link the chosen layout to all records with the selected field different from the input
value.

™ Contains - Link the chosen layout, based on the field value, to all the records that contains the
input value.

[M Not Contains -Link the chosen layout, based on the field value, to all the records that do not
contains the input value.

E Is Null - Link the chosen layout to all records where the selected field is a null value.
E Is Not Null - Link the chosen layout to all records where the selected field is not a null value.

(i ] After you have chosen one condition, you can set it to match any string, like shown on previous

picture '.' however please notice that the condition is not case sensitive.
0 If the record doesn't comply to any condition it will assume the layout of the previous record.

0 What benefits may be obtained from using multiple layouts? To explain it, we will show you a
sample case using one of the predefined templates available with cardPresso.

Q Now let’s imagine that you have three different departments in your company, Sales, Marketing
and another one that for this example purpose we will call it General, but only one database and you
need distinguish them visually for faster identification. The process is simple:

0 After opening one of our predefined templates, a connection to an internal database will be made
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CPF Fle Edt Yeew Tool [Database Wndow Help
(=] Ll 1 Ll 1 Ll Ll 1 1
EEESLE s OsdEE AR HEEEEE - BE-
B T T T P T T EEER R BE E
== I 5| il
Ciatabais
i Pragram Dataic ardPretsoDATABASE irtermaiDatak
— Table Employes
—
Record 1 of 15
! Arst Mame -
"__ Sania
1k ;
s [ Postion
l g - Sales Reprosertati
g girth Date
L 2t 1572/12/08 (00:00:00) 2
m g Hire Date
= _.3 1991002 (0:00:00) -5
' o
m E . _E_ Hame Phone
1; N 5‘0 nla. {206]555-0857
m Davolio
F Extunsion
o
' 2 {
z L # noeme phone (208)6656-9856T E
xr :
1R .
¥ EI !B ils Nl

It’s time to start working on the card layouts. Now click on the Layout Tab.
As you can see you already have one layout, from cardPresso business card.

Now we will add two new layouts in order to have three different layouts for sales, marketing and
general departments.

To start, change one of the layout's name to Marketing and then click on the auto select checkbox
to set the conditions.

On the database field, choose the field that will define the layout selection, in this case will be the
Position field.

Then in the next drop list set the condition for the chosen field, on our example we set it to
'‘Contains’.

And on the text box below add a value for the condition. In this case is the department's name,
remember that this is not case sensitive.

Finally, enable the 'Auto select' checkbox. This option allows you to see the card layout that
depends on the condition field type when scrolling through the database records.
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stom

ourlogo
Yy 9

Cul

|Marketing |

Background

[ Add I l Copy
Auto Select based on database condition

Clipart

[ Position | = ]

[ Contains | L4 ]

|Marketing |
Auto select on card design

yourlogo

Sonia
Davolio

=
=
=
Q
]
]
o
]
friv]
i
o]

Now choose our distinguish color for the card that in our example is what will define visually the
different departments.

CF Fle Edt yiew Tol Database Window Help

REEES O08E AAA  BEEEEE - BE-

Vesvaias aan e Sobd Al &l

yourlogo

‘ SDnia
o Davolio

nome phone | 208)655-985T

EPBEEEBREE =0l

& More Colars...

El
&
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Now add a new layout for Sales and General departments. Click on the copy button twice.

As you see it copies our previous card to the new layout. All we need to do now is the same
procedure we made for the Marketing layout.

Define database settings for each new layout.

CP Fle Edit Yeew ol Database Wndow Help

mEELE S O=aE AR

7
vaahaamasnsalisisls

O

[ o | Backgrouns | custom JGM

|

A Copy Dalate
¥ Auto Select based on database condition

Layouts |

I yourlogo

e - |

Cantaing -]

Gabes marketing
B Auto select on card design

: r Sonia
E Davolio

EFBEEBR-=0oNml B

£
=

Now use the navigation buttons and start scrolling through the database records.

As you can see, now the setup of the card is finish, connected to an excel database and with three
different layouts to define the different departments.

1] But this is an example, you can choose as many layouts as you want and set your own
conditions.

4.2.4 - Script

i ] There are two different scripts on cardPresso, one for each object and one for the document. In
this chapter we focus on the card document script

This is an advanced user area, where you can program actions and procedures in ECMEAScript
language in order to define settings or update your object.
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[ When Document Loaded . v

When Document Loaded
Before Print

Before Print Record
After Print

After Print Record

Audit Successful Print
Database Connected
Database Disconnected

]
c
=
o
L
o

iy
[=)
]

m

Scriptfj | Output | @

'.' This first drop-menu allow you to define when this actions or procedures must take place.
. And on the space bellow you can write your lines of code.

'.' To see the log of your program output, change tab bellow.

4.3 - Document Objects

0 This objects are the most important features of your card document creation process. There are
two maijor types of objects, static and dynamic.

The first class refers to objects that will never change along the creation or data input process, like
backgrounds and shapes, for instance.

The second ones can be static or variables. Static as a simple keyboard input text line can be but
when we connect the same text line to a database and make it change while browsing through
several records it makes it a variable object according to its data source.

The objects can be placed throughout the card space, in the front and back side. And can be
arranged as you wish in order to overcome your creation needs.

There are also a set of specific settings to each object that you can use according to your own
specifications, like color, size, source, among many others.

New New New New New Print Print New 1D
Line Rectangle Circle Shape Text Counter Date Barcode

& & 1o
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New 2D Browse Aquire New
Barcode Imaae Imaae Imaae
431 -Line

0 This object is a simple straight line, but still have some features that you can setup. You can
choose between five different kinds of lines and a custom one

| solid
'F'\ " c Line Width | 2 mm
s E
(=]
o
™~ ~
MR I
|_M0re Colors...
|_Advanced...‘

E Solid Line: Is a plain line.

™ Dash Line: Dashes separated by a few pixels.

™ Dot Line: Dots separated by a few pixels.

[ DashDot Line: Alternate dots and dashes.

[ DashDotDot Line: One dash, two dots, one dash, two dots.

Ef The Custom Line is a line that you can define as you wish. By clicking on the 'advance' button
you can set additional parameters like offset and pattern.

. Line width: varies between 0.1 to 10 mm.

. You can, also, change the color by clicking in one of the colored squares, acquire any color you
have on your screen using the dropper or use the advance color settings by clicking on the 'More
Colors' button.

Q By clicking on the advance button you have access to settings that allows you to change the
shape of your line. All you have to do is to write the command on the line like shown bellow.
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/RoundCap /SquareCap

Pen Parameters:

/SquareCap|

/squareCap jFlatCap /RoundCap [ = y .Cancel.

E SquareCap: A square line end that cowers the end point and extends beyond it by half the line
width.

E FlatCap: A square line end that does not cover the end point of the line.
™ RoundCap: A rounded line end.

o If you right click on the object a pop-up menu is shown allowing you to:

Copy Ctr+C
Delete Del
Duplicate  Ctrl+D

m Send Te Front
W Send To Back

Fit to Card

E Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.
The object will no be available to external programs.

E Delete - Deletes the selected object.

™ Duplicate - Creates an exact copy of the object on the work space.

™ Send to Front - Send the object to the front of all objects on the work space.
™ Send to Back - Send the object to the back of all objects on the work space.

4.3.2 - Rectangle

0 This object can be either a rectangle or a square, depending only of the side measures.

olf you right click on the object a pop-up menu is shown allowing you to:
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Copy Ctrl+C
Delete Del
Duplicate  Ctrl+D

m Send To Front
W Send To Back

Fit to Card

K Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.
Ef Delete - Deletes the selected object.

E Duplicate - Creates an exact copy of the object on the work space.

E Send to Front - Send the object to the front of all objects on the work space.

™ Send to Back - Send the object to the back of all objects on the work space.

0 You can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.

4.3.3 -Circle

6 This object can be either a circle or an ellipse. By moving the delimitation lines you can change
the appearance of the object.

olf you right click on the object a pop-up menu is shown allowing you to:

HE 1
E Copy ctri+c
i Delete Del

Duplicate  Ctrl4D

A Send T Front
W Send To Back

----- Fit to Card

E Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.
Ef Delete - Deletes the selected object.
E Duplicate - Creates an exact copy of the object on the work space.

E Send to Front - Send the object to the front of all objects on the work space.
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E Send to Back - Send the object to the back of all objects on the work space.

© vou can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.

4.3.4 - Shape

O is object can assume many different shapes. On the Shape Tab you have a dropdown menu
with sewveral categories of shapes. Inside each there are seweral shapes that you can add to your
card.

0
3
g
&

2

o

Copy Ctri+C

Delete Del

O i A e

-
==

Duplicate Ctrd+D

-
-
-

W Send To Front
W send To Back

= QD™ ;
H=D
ofo - B = 3 e

\.

O 8 e

—
Fit to Card @ IE >
2 Ccolor
L )L TEEE - LY TEEEES ---a » |5
| P i | & |[Rre26907, 99 -
4.8 W
- - wi-- S K v

O voucan change the color by clicking in one of the colored squares, acquire any color you have
on your screen using the dropper or use the advance color settings by click on the 'More Colors'
button.

You can also setup a number of properties and settings on the properties tab, on the right of your
screen.

olf you right click on the object a pop-up menu is shown allowing you to:

™ Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.
E Delete - Deletes the selected object.

K Duplicate - Creates an exact copy of the object on the work space.

M Send to Front - Send the object to the front of all objects on the work space.

E Send to Back - Send the object to the back of all objects on the work space.

© 2013 cardPresso



Chapter 4. Design “

0 All properties and settings will be addressed further on this manual.

4.3.5 - Text

O The text object allows you add text to your card document. After positioning the text on the card

design area double-click on it

Please enter text

Your Text]

to start typing your text. The default text format is a text box.

Close

0 There are three kinds of text objects: numeric, alphanumeric and Lists.

With the alphanumeric text objects, you can use a single line text or a text box, that allows you to
write more then one line of text.

The numeric type is divided in

numeric, integer and date/time.

There is also Lists and Database Lists, that are no more than a small list with two fields, one works

as an index and the other as t

he data that the object should display.

olf you right click on the object a pop-up menu is shown allowing you to:

L B 1

& our Text .

i Copy ctri+C

fomemes Delete Del
Duplicate  Ctrl+D

W Send T Back

Fit to Card

m Send To Front

E Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.

E Delete - Deletes the selected object.
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Ef Duplicate - Creates an exact copy of the object on the work space.
Ef Send to Front - Send the object to the front of all objects on the work space.

E Send to Back - Send the object to the back of all objects on the work space.

O an properties and settings will be addressed further on this manual.

4.3.6 - Print Date

0 The Print Date object allows you to print on the card the current printing date and/or time.

You can set the update of the object to manual or automatic and interact with a database field.

Ot also allows you to define the date and time format.

00000001+ ©00000001[ corr  cuiee

Delete Dl

+ Duplicate Ctrl+D
A

m Send To Front
& Send T Back

At to Carg

olf you right click on the object a pop-up menu is shown allowing you to:

™ Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.
Ef Delete - Deletes the selected object.

E Duplicate - Creates an exact copy of the object on the work space.

E Send to Front - Send the object to the front of all objects on the work space.

E Send to Back - Send the object to the back of all objects on the work space.

O an properties and settings will be addressed further on this manual.

4.3.7 - Print Counter

© The Print Counter object allows you to set a counter and print it on the card.
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You can set the update of the object to manual or automatic and interact with a database field.

0 It also allows you to define the counter numeric format and values.

+ D605 Copy Ctri+C

............. T T L e Delete Del
A ﬁ Duplicate  Ctr+D

m Send To Front
W Send To Back

Fit to Card

olf you right click on the object a pop-up menu is shown allowing you to:

™ Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.
Ef Delete - Deletes the selected object.

E Duplicate - Creates an exact copy of the object on the work space.

E Send to Front - Send the object to the front of all objects on the work space.

E Send to Back - Send the object to the back of all objects on the work space.

O A properties and settings will be addressed further on this manual.

4.3.8 -1D Barcode

O This object allows you to create a barcode. A barcode is an optical machine-readable
representation of data relating to the object to which it is attached.

There are many diferent barcodes types, Code 128, EAN-8, UPC among many others. Each one
with different features and settings..

You can setup to see only the bars or complement it with readable data.

O 1t also allows you to connect the object to a database field and became a dynamic readable
source.
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olf you right click on the object a pop-up menu is shown allowing you to:

™ Copy - Click on the copy option or use the shortcut 'CTRL+C' to copy the object to the
clipboard.

™ Delete - Deletes the selected object.
E Duplicate - Creates an exact copy of the object on the work space.
E Send to Front - Send the object to the front of all objects on the work space.

E Send to Back - Send the object to the back of all objects on the work space.

0 All properties and settings will be addressed further on this manual.

4.3.9 - 2D Barcode

0 This object allows you to create a 2D barcode. A 2D barcode is also an optical machine-
readable representation of data relating to the object to which it is attached, ewlved from the 1D
barcode into rectangles, dots, hexagons and other geometric patterns in two dimensions (2D).
Although 2D systems use a variety of symbols, they are generally referred to as barcodes as well.

There are many different 2D barcodes types, PDF417, Datamatrix, QR-Code between others. Each
one with different characteristics.

0 You can also connect the object to a database field and became a dynamic readable source.

[ | [ |

E Copy ctr+cC

[ | Delet Del
ns elete =

Duplicate  Ctrl4+D

m Send To Front
W Send T Back

Fit to Card
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O Piecase be aware that this obiect is only supported on XM and XL cardPresso editions.

Q If you right click on the object a pop-up menu is shown allowing you to:

™ Copy - Click on the copy option or use the shortcut 'CTRL+C' to copy the object to the
clipboard.

Ef Delete - Deletes the selected object.

E Duplicate - Creates an exact copy of the object on the work space.

E Send to Front - Send the object to the front of all objects on the work space.
E Send to Back - Send the object to the back of all objects on the work space.

O an properties and settinas will be addressed further on this manual.

4.3.10 -Image

O mis object is a very important one, not only because it allows you to add and work an image on
your card, but also allows you to transform that image in your card background.

An image can be add to your card from any source available like a scan device, camera, disc or
cloud and allows any kind of image, jpg, png and others.

With cardPresso you can transform that image as you want, changing color, light, size and many
other settings.

O Make it your card background is easy, right click on the image and chose 'Set as
Background' and your picture is adapted to your card size.

= ol (=

Copy ctrl+c
Delete Del
Duplicate Ctrl+D

w

m Send To Front
W Send To Back

Export Image
Set As Background

Ft to Card

| EEEEEEC RO EEE e PR EEL T

OIf you right click on the object a pop-up menu is shown allowing you to:
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E Copy - Click on the copy option or use the shortcut 'CTRL+C' to copy the object to the
clipboard.

™ Delete - Deletes the selected object.

™ Duplicate - Creates an exact copy of the object on the work space.

™ Send to Front - Send the object to the front of all objects on the work space.
™ Send to Back - Send the object to the back of all objects on the work space.

E Export Imaae - Allows vou to export the imaae as a file to anvwhere on vour computer.

™ Set As Background - Set the image as the background of your layout.

0 All properties and settings will be addressed further on this manual.

4.4 - Objects Properties

0 cardPresso has a properties space, shown on the right side of your screen and you can display
it as a set of tabs or a tree set as pictures below. To change just right click on an empty space on
the tab and check one of the options.

—

D ltem

[ITEM_34DFo1B4 | o
=) Group [ITEM_34DF91B4 |
3 | |
= Group
=) Options [ |
% [ Design not allowed oot
= . ptions

O Do Not Print [] Design not allowed

Opaci [ Do Not Print
p

P Opacity
r f U
Paosition
v Tabs
B Clipping

Tree

c
=)
E
o
gs!
vl

Outline

Rotation

Outline

Fill

These tabs change depending on the object we are dealing on the working area and as you will see
further on this manual.

0 Script, Layouts, Clipart and Background are the four basic tabs already refered on the 'Card
Document Settings' chapter. These tabs are shown after you chose your card model and are
previously referred to in this manual.
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441 -ltem

O The Item tab allows you to define the ID, Group and visibility of an object.

[item

D
ITEM_34DF91B4

Group

Options
[] Design not allowed
[1 Do Mot Print

Opacity

U

Clipping
™ Object ID - Defining object ID not only helps you organizing data on your document, but also
gives you an easier object identification and helps you on encoding operations.

When manipulating a database you can use an ID to identify objects that will help you while
programming a script.

The options settings allows you to:

™ Design Not Allowed - Check the 'Design not allowed' box protecting the object from been
change, but only the graphical appearance and drag&drop position, not the content.

E Do Not Print - Check this option when your object is not supposed to be printed on the card.

™ Opacity - You can also define the opacity level of the object by scrolling the opacity button, from
0, default position to 100%. This option is applied to all object including background.

4.4.2 - Position

O In this tab you can set the position manually or check the real-time position when moving and/or
resizing the object directly in the card design area.

The same property applies to the object dimensions, allowing you to manually change the width and
height of the object with a higher precision level.
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Item

|

Position

X [8.019 mm

Y [9.283 mm
Width  [31.015 mm
Height [29.112 mm

Clipping

4.4.3 - Clipping

6 This option allow you to change the visual shape properties of an object, setting it up the \isible
area of that object with three different formats, circle, rectangle or round rectangle.

Item

TII

Position
|

clipping ﬁ!

l Rounded Rectangle
[ Founded Rectangle | v]

X Radius:
Circle
[4 mm | '-l Rectangle
¥ Radius: Founded Rectangle
[4 mm | v_|

Outline

Rotation

It's like hidden the image behind a layer with a hole in the middle, and the shape of that hole define
the visible part of our image like shown bellow. For instance if you chose a circle shape the area of
the photo that’s sitting directly above the circle content area now remains completely visible.

QOriginal Clipping Effect Format After Clipping Effect

OTo define the clipping area and format all you have to do is dragging the image boundaries.
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4.4.4 - Rotation

i this tab you can rotate or define a rotation angle to your object... Or you can select more than
one object and apply a rotation to all the selected objects at the same time.

Clipping

Outline

Rotation ‘

'.' The softwares has quick rotation buttons for the most commons rotations, 0, 90, 180 and 279
degrees rotation. You may also rotate the object in increments and /or decrements of 45 degrees
(also avaialble using the shortcut '‘Backspace").

. If you wish to apply a more specific rotation use the edit box available for those situations

. Or turn the round button to the desired angle, updating at the same time the angle box value.

0 All these changes are seen in real-time on the object.

4.4.5 - Outline

(i ] Outline allows you to chose between five different types of predefined types of lines and a
custom one.
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Clipping
Outline |

Your Text. 1 [oash ot memememememems @

—— - Line Width |.3.25 mm - .

B

. _of 0 |
. More Colors...
Advanced...

Rotation

Solid Line: Is a plain line.

™ Dash Line: Dashes separated by a few pixels.

™ Dot Line: Dots separated by a few pixels.

[ DashDot Line: Alternate dots and dashes.

[ DashDotDot Line: One dash, two dots, one dash, two dots.

[ The Custom Line is a line that you can define as you wish and if click on the advance button
besides the normal advanced parameters you are allowed to set offset and pattern parameters.

. Line width is one of the settings that you can change from 0.1mm to 10mm

. You can, also, change color by clicking in one of the colored squares, acquire any color you
have on your screen using the dropper or use the advance color settings by click on the 'More
Colors' button.

Q Clicking on the advance button you have access to a serial of settings that allows you to
change the shape of your line. All you have to do is to write the command on the line like shown
bellow.
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/RoundCap /SquareCap

Pen Parameters:

|/squarecap| |
/SquareCap FlatCap /RoundCap [

0K |[ Cancel |

E SquareCap: A square line end that covers the end point and extends beyond it by half the line
width.

E FlatCap: A square line end that does not cover the end point of the line.

E RoundCap: A rounded line end.

4.4.6 - Fill

(i ] Define the fill color you want to see applied on your object, in case of lines, rectangles or circles
it will change the color of the object, on all other cases it will change the background color.

Outline

Fill |

' Solid Fil B

| 2
More Colors...|

Ef No fill: No color is applied to the object.

™ Solid Fill: Fill the area with only one color and you can define the color using the standard
pallet, the dropper or clicking in "More Colors" button using the advanced pallet.
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™ Gradient Fill: Allows you to pic a second color and make a gradient effect with both colors and
define both colors using standard pallet, the dropper or clicking in "More Colors" button using the

advanced pallet.

™ Dropper - In case of using the dropper you can select any color, even outside the program
window, like shown on the first picture below. After the color is apply to the object and added to the

color pallet as you can see on the second picture.

Rotation

Outline

Fill

| solid Fil B

7|
More Colors...

Script ]

Ef More Colors - Gives you access to an advanced color pallet

Ef Basic Pallet Color Theme - To chose a theme for your basic pallet color use the drop menu
like shown on the picture bellow and then theme is automatically applied to the basic pallet color.

© 2013 cardPresso



90% Black f\ \

Bananas
Black Body
Camouflage
Candy
Christmas
Coral reef
Desert
Earthtones
Easter

Eyes
Feminine
Fire

Fleshtones
Metallic

Midnight
Mountain
Mud
Donsil
Rainbow
ROSes
— Sand
Shades of Autumn
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Hue [101

’e‘

Red (90

’e‘

Sat 237

,%] Green |254 ,%]

val 254 4] Blue 13 [

[

oK ” Cancel ‘

0n this example choosing Rainbow option will apply to the basic color pallet only colors related

with Rainbow theme.

Ef Unusual Color - In the case you want do add an unusual color, you have two ways to do it, you
can drag the crossair through the panel or input directly the color values on the boxes.

After that the new color is added to the basic color pallet.

447 -Font

6 When you select the 'Font' tab, a number of tools allows you to define the font of your object.
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E

v
d
.

Outline |

Booonmnonenene Wenooonennenenee .
Font i]j E ! i
Font Family [ EEEEEREPEEREEErs Beooemmmeaaeae i
| Arial Arial vl
0/ = .

Point Size T Arial
0o @) T Arial Black
Color T Anal Narrow
(W r152c08102 .j T Arial Rounded MT Bold
Typeface T Arial Unicode MS
T Arno Pro
'L l‘ L . T Arno Pro Caption
T Arno Pro Display

T Arno Pro Light Display
T Arno Pro Smbd

[ word wrap .

T Arno Pro Smbd Caption
. T Arno Pro Smbd Display
; T AUdimat
' Tr AvantGarde Bk BT AaBbzZ
________ Llass | T AvantGarde-Book Th _AdRhz7_ 7

'.' First you hawve the 'Font Family' where you can chose the font type, all fonts that you have in

Windows or on your OSx are displayed here.

. Point Size - Allows you to define the font size, if you check on the checkbox the size is
determined by the space available between boundaries, to change just drag and drop the selection

handles.
. Color - Chose the font color

. Typeface allows you to define more font settings like:

BIU

. You can also wrap the sentence on your object by checking the 'Word Wrap' checkbox.

, iYour
i ;Text...

S
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0 The bar code properties allows you to define some properties depending on the type of barcode
you want to use. There are two major types of barcodes the 1D and 2D, illustrated bellow, like

refereed previous on this manual.

x
(=] s

0

referenced on cardPresso:

™ Type: Chose the type of barcode you wish to use, keeping in mind that in some cases your

Fill

Barcode ‘

| Code 128

Barcode color

[CJRs16255851 g

Module width

| Auto v|

Bearer bar

| No bearer bar

Bearer width
0.75 mm

Quiet Zone

|Gmm

Human readable

| Below

Font

| Normal

CheckDigit

|N0ne

Source

Let's start by making a general introduction, to the most commune properties of barcodes,

choice may change other properties range of values.

™ Color: Define you barcode color.

E Human Readable: Defines if the readable data, alphanumeric characters, is imprinted or not

(only 1D barcode).

E Font: Defines the font of the readable data (only 1D barcode).

0 Other properties and definitions are specific to each different type of barcode, therefore will be

addressed further on this manual.
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449 -Image

© voucan acquire images from any source available, from disk, from database, from a camera or
even from a scanner.

window  Halp

& — - 1] 2
.ﬂat_'.i‘@ HE S B

E,‘ Al glasses
= B
e 3
i H
® =
: z
|
B :
=
m| .
&
(3
e

O After you select an image and apply it to your working area, you have access to a new tab, the
image tab. On this tab you can change a set of properties like:

E Keep Ratio - Allows you to adapt the image to your object boundaries or keep the image ratio.
Ef Reinforce Black

™ Flip Horizontal - This option reverses the active object horizontally, that is, from left to right. It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central vertical axis of the object.

E Flip Vertical - This option reverses the active object ertically, that is, from top to bottom. It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central horizontal axis of the object.

K Grayscale - Applys grey scale on the image in which the value of each pixel is a single sample,
that is, it carries only intensity information. Images of this sort, are composed exclusively of shades
of gray, varying from black at the weakest intensity to white at the strongest.

K Chromakey Effect - Turn the chromakey effect on and off in which a color range in the top layer
is made transparent, revealing another image behind.

E Color - Allows you to choose the color range on which the effect will act. Use the dropper to
chose any color on the image.

™ Tolerance Level - Allows you to change the tolerance level of the effect. The bigger the
tolerance, the larger the range of colors affected by the effect.

© 2013 cardPresso



Chapter 4. Design

™ Effect area - Select the area of the image affected by the effect, if all image or only on the
frame.

o If you double click on the image the Image Editor opens with more edition tools.

4410 - Source

0 The Source Tab allows you to define the origin of the object and parametrize that same object.
In cardPresso you have two major object classes, the images and all the text objects.

Source
| From Disk
Title /
|Please browse image me DISk v
Source From Disk
From Camera or Scanner

| C:/Disk/Projectos/CardPresso/Templ| From Signature Pad
From Photo Editor

Updated From Database
Item Link
| When ltem Double-Clicked YT T

Save with document

|‘|‘Es

Format

| Image Free format

Face Detection

|N0

Open image editor

| Only when error

0 On text object and barcodes the source can be a print counter, a print date, a keyboard input,
database or item link.

On image objects an signatures the source can be the disk, a camera or scanner, the image editor,
a database field or an item link.

On the next chapters we will show you how to use them and how to define them, in sum
how easy is to manipulate any of the sources or its properties.

4.4.10.1 - Text & Barcode

i ] When you hawe a text or barcode object selected you can use the Source Tab to set the input
options for the object

0 On this tab you will define what kind of object it is, how it is updated, under what condition will
be updated, when it will be updated and the final result.
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Source |

[ Keyboard Input All I}eyboard Input |-..—J
Print Counter /
Print Date /— Title

keyboard Input |Please enter barcode data |
Database
Iltem Link Updated

[ When Item Double-Clicked | » J

Save with document
No ||
Data Type

.] Text Line | v | [ee)

4.4.10.1.1 4.4.10.1.1 - Print Counter

(i ] This feature allows you add a print counter to your card. Can be updated automatically, saved
with your card file, keeping this way, the counter status. You can also define values, justify and

number of digits like explained further on this manual.

When a text object is selected, you can go to the Source Tab and on the dropdown menu, on top,
choose Print Counter option or click on the 'Print Counter' button on the design toolbar.

0 You can update your counter in five different situations
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| Print Counter

Updated
Before Print = | Before Print Card
When Item Double-Clicked b o
When Load Document ’- — ave with document
Before Print | Yos

Before Pnnt Card
After Print Card

Clipping

Minimum Value

1 5
E Maximum Value
£ (99999999 =
o
=8| Restart Value
c |1 [ -l
o
=N Increment Value
& 1 =

Current Value
: -

o
=
=
=
O

|ustified with zeros

| Yes

Number of digits
[a]
E |

Font auto adjust

o

U .

=] | Newver
o L

]

h Concatenation

o

o

-

(%]

W

E When Item Clicked - When you double-click on top of the object it will update the counter
according to all the settings.

E When Load Document - Every time the card document is opened.

™ Before Print - Count the number of times you send a print order and update the counter before
the printing procedure.

Ef Before Print Card - Count the number of cards you print and update the counter before each
time a card is printed.

E After Print Card - Count the number of cards you printed and update the counter after printing
each card.

™ Save with Document - Save the settings and counters with the document so you don't loose
any data.

E Minimum Value - Defines the counter minimum value in case of negative incrementation.
E Maximum Value - Defines the counter maximum value in case of positive incrementation.

™ Restart Value - Is the value assumed by the counter when reaches the maximum or minimum
values. (Min Value < Restart Value < Max Value)
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[ Increment Value - Defines the incrementation value, it can be positive or negative.
[ Current Value - Shows the current value.
E Justified with Zeros - Justify with zeros until the number of digits.
[ Number of Digits - Defines the number of digits used in the counter, you can justify with zeros.
™ Font Auto Adjust - Automatically adjust the font size, but only if font point size is auto.
E Concatenation - Allows you to add a prefix or a suffix to your counter value and it can be
printable, to do that just check on the check-box.
4.410.1.2 4.4.10.1.2 - Print Date

0 This feature allows you add a date object to your card. Can be updated automatically, saved with
your card file, keeping this way, the date status. You can also format the date and time, like
explained further on this manual.

When a text object is selected you can go to the Source Tab and on the dropdown menu, on top,
choose Print Date option or click on the 'Print Date' button on the design toolbar.

| print Date

Updated
|- Before Print Card

Before Print =
When Item Double-Clicked b .
When Load Document ’- — ave with document

BEetore Print I
EBefore Print Card | Yes

Clipping

Format

| dd-MM-yyyy (hh:mm) | = | (... ]
Font auto adjust

Alignment

| Mewver

Concatenation

Increment Value

1 2
Current Value

1 4]

|ustified with zeros

Rotation

Outline

| Yes

Number of digits
; -
Font auto adjust

o

o .

3 | Mewver
o L

wn

2 Concatenation

o

=3

P

(%]

wn
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0 You can update your date/time in five different situations.

Ef When Item Clicked - When you double-click on top of the object it will update the date and
time.

E When Load Document - Every time you open the document it will automatically update the
date object.

™ Before Print - Update the counter before the printing procedure starts and all the cards are
printed with the same date and time.

E Before Print Card - Update date and time before printing each card.

Ef Save with Document - Save the settings and date/time of last printing procedure with the
document so you don't loose any data.

E Format - You can format date using a preset format by clicking on the arrow pointing button or
creating your own format by clicking on the pointed button and then write it according with the legend
bellow.

|dd-MM- (hh:mm) fl E] Date and Time format

“MM-dd i ] dd-MM-yyyy (hh:mm)

Yyyy-MMM-dd oK cancel
yyyy-MMMM-dd
WjMM;dciid d the day as number without a leading zero (1 to 31
yyyy/MMM/ dd  the day as number with a leading zero (01 to 31)
yyyyMMMM idd ddd the abbreviated localized day name (e.g. ‘Mon'to
dd-MM-yyyy dddd the long localized day name (e.q. ‘Monday’ to 'Sun
dd-MmMM- M the month as number without a leading zero (1-12

YYYY MM the month as number with a leading zero (01-12)
dd-MMMM-yyyy MMM the abbreviated localized month name (e.g. 1an’ t
derMM;W MMMM the long localized month name (e.g. January to 'D
dd/MMMyyyy Wy the year as two digit number (00-99)
hhemm wyyy the year as four digit number

- Time
hh:mm:ss h the hour without a leading zero (0 to 23 or 1 to 12 if AM,
hh:mm:ss:zzzz hh  the hourwith a leading zero (00 to 23 or 01 to 12 if AMf1
dd-MM-yyyy (hh:mm) m tﬁ minute M‘L]l::ou:. a Leadlnu ze[m (ot 5)9}
dd-MM-WW {hh:mm:SS) mm  the minute with a leading zero 00 to 59
s the second without a leading zero (0 to 59)

dd/MM/yyyy (hh:mm) ss  the second with a leading zero (00 to 59)
ddiMmMpyyyy (hh:mm:ss) z the milliseconds without leading zeroes (0 to 959)

zzz  the millisecends with leading zeroes (000 to 999)
AP use AMPM display AP will be replaced by either "AM® or
ap use am/pm display. ap will be replaced by either "am" or

E Font Auto Adjust - Automatically adjust the font size, but only if font point size is auto.

E Concatenation - Allows you to add a prefix or a suffix to your date and it can be printable, to do
that just check on the check-box.

4.4.10.1.3 4.4.10.1.3 - Keyboard Input

O mis setting allows you add an object to your card that is updated by keyboard input. It can be
updated automatically, saved with your card file. You can also choose the data type like explained
further on this manual.

When a text object is selected, you can go to the Source Tab and on the dropdown menu, on top,
chose Keyboard Input option.
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E Title - You can give a name to your object, it will make it easier for further identification.

0 You can update the object in six different situations.

Fill

Font

Source |

| Keyboard Input TextBox Properties

Title Columns 80

|Please enter text
Updated

[Befare Print Card Fows |6 |3

v
When Item Double-Clic JJ‘
On Custom View

} OK Cancel
Stof Before Print Card v
On Edit View '\F—( ’ LA
when Load Document ave with document
Before Print
Before Print Card ﬁ_“u’| No vJ
After Print Card Data Type
Text Box N\ ( | Text Box { \/

Text Line Font auto adiust
ont auto adjus T
;rfexl:t Box ! Textling Properties
alue
Never
Integer Value | J Data Length [0
Date

Walidation Rules
Date and Time

Database list 2

|

E When Item Clicked - When you double-click on top of the object it will open an input window to
update.

™ On EditView - This setting, when chosen, allows you add a new field to a small internal
database, as you'll see further on this manual.

Ef When Load Document - When the card document is loaded this object is updated.

E Before Print - After the print order and before start printing, it will open an input data window in
order to allow you to update the object, after that it will not be update again until next print order, on
the example below was date field.

™ Before Print Card - Before print each card, it will open an input data window in order to allow
you to update the object, on the example below was date field.

E After Print Card - After print each card, it will open an input window in order to allow you to
update the object for the next card, on the example below was date field.
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Print Record 1 of all

Please enter text

[2000/01/01 ]

Cancel Continue

Ef Save with Document Save on your card document the last object update.
E Data Type On this setting you can define what kind of data your object can hold.

E Text Line - Allows you to input text information in one line.

TextLine Properties

Data Length (g0
Input Mask
Validation Rules

oK Cancel

K Data Length - Defines the length of your text line (maximum of 128 characters).

E Input Mask - The mask consists of a string of mask characters and separators. You can define
your object input guide by choosing the mask or the Validation Rules, when both the mask prevails.

Character Meaning

ASCII alphabetic character required. A-Z, a-z.

ASCII alphabetic character permitted but not required.
ASCII alphanumeric character required. A-Z, a-z, 0-9.
ASCII alphanumeric character permitted but not required.
Any character required.

Any character permitted but not required.

ASCII digit required. 0-9.

ASCI digit permitted but not required.

ASCI digit required. 1-9.

ASCII digit permitted but not required (1-9).

ASCII digit or plus/minus sign permitted but not required.
Hexadecimal character required. A-F, a-f, 0-9.
Hexadecimal character permitted but not required.
Binary character required. 0-1.

Binary character permitted but not required.

All following alphabetic characters are uppercased.

All following alphabetic characters are lowercased.
Switch off case conwversion.

Use \ to escape the special characters listed above to use them as separators.

— = AVOWUWSTIHQTUOOX XTI Z0 >
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Q@ Examples:

Mask Notes

000.000.000.000;_ IP address; blanks are _.

HH:HH:HH:HH:HH:HH;_ MAC address

0000-00-00 ISO Date; blanks are space

>AAAAA-AAAAA-AAAAA- License number; blanks are - and all (alphabetic) characters are
AAAA-AAAAA;# converted to uppercase.

E Validation Rules - Validation Rules are built up from expressions, quantifiers, and assertions.
The simplest expression is a character, e.g. x or 5. An expression can also be a set of characters
enclosed in square brackets. [ABCD] will match an A ora B or a C or a D. We can write this same
expression as [A-D], and an expression to match any capital letter in the English alphabet is written
as [A-Z].

A quantifier specifies the number of occurrences of an expression that must be matched. x{1,1}
means match one and only one x. x{1,5} means match a sequence of x characters that contains at
least one x but no more than five.

Note that in general Validation Rules cannot be used to check for balanced brackets or tags. For
example, a Validation Rule can be written to match an opening HTML <b> and its closing </b>, it
the <b> tags are not nested, but if the <b> tags are nested, that same Validation Rule will match an
opening <b> tag with the wrong closing </b>. For the fragment <b>bold <b>bolder</b></b>, the first
<b> would be matched with the first </b>, which is not correct. However, it is possible to write a
Validation Rule that will match nested brackets or tags correctly, but only if the number of nesting
lewvels is fixed and known. If the number of nesting lewels is not fixed and known, it is impossible to
write a Validation Rule that will not fail.

Suppose we want a Validation Rule to match integers in the range 0 to 99. At least one digit is
required, so we start with the expression [0-9]{1,1}, which matches a single digit exactly once. This
Validation Rule matches integers in the range 0 to 9. To match integers up to 99, increase the
maximum number of occurrences to 2, so the Validation Rule becomes [0-9]{1,2}. This Validation
Rule satisfies the original requirement to match integers from 0 to 99, but it will also match integers
that occur in the middle of strings. If we want the matched integer to be the whole string, we must
use the anchor assertions, * (caret) and $ (dollar). When * is the first character in a Validation Rule,
it means the Validation Rule must match from the beginning of the string. When § is the last
character of the Validation Rule, it means the Validation Rule must match to the end of the string.
The Validation Rule becomes /0-9]{1,2}$. Note that assertions, e.g. » and $, do not match
characters but locations in the string.

If you have seen Validation Rules described elsewhere, they may have looked different from the ones
shown here. This is because some sets of characters and some quantifiers are so common that
they have been given special symbols to represent them. [0-9] can be replaced with the symbol \d.
The quantifier to match exactly one occurrence, {1,1}, can be replaced with the expression itself, i.e.
x{1,1} is the same as x. So our 0 to 99 matcher could be written as N\d{1,2}$. It can also be written *
\d\d{0,1}$, i.e. From the start of the string, match a digit, followed immediately by 0 or 1 digits. In
practice, it would be written as MNd\d?$. The ? is shorthand for the quantifier {0,1}, i.e. 0 or 1
occurrences. ? makes an expression optional. The Validation Rule Md\d?$ means From the
beginning of the string, match one digit, followed immediately by O or 1 more digit, followed
immediately by end of string.

To write a Validation Rule that matches one of the words 'mail' or 'letter’ or 'correspondence'’ but does
not match words that contain these words, e.g., 'email’, 'mailman’, 'mailer’, and 'letterbox’, start with
a Validation Rule that matches 'mail'. Expressed fully, the Validation Rule is m{1,1}a{1,1}i{1,1}{1,1},
but because a character expression is automatically quantified by {1,1}, we can simplify the
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Validation Rule to mail, i.e., an 'm' followed by an 'a’ followed by an 'i' followed by an I Now we can
use the vertical bar |, which means or, to include the other two words, so our Validation Rule for
matching any of the three words becomes mail|letter|correspondence. Match 'mail' or 'letter' or
‘correspondence’. While this Validation Rule will match one of the three words we want to match, it
will also match words we don't want to match, e.g., 'email. To prevent the Validation Rule from
matching unwanted words, we must tell it to begin and end the match at word boundaries. First we
enclose our Validation Rule in parentheses, (mail|letter|correspondence). Parentheses group
expressions together, and they identify a part of the Validation Rule that we wish to capture.
Enclosing the expression in parentheses allows us to use it as a component in more complex
Validation Rules. It also allows us to examine which of the three words was actually matched. To
force the match to begin and end on word boundaries, we enclose the Validation Rule in \b word
boundary assertions: \b(mail|letter|correspondence)\b. Now the Validation Rule means: Match a word
boundary, followed by the Validation Rule in parentheses, followed by a word boundary. The \b
assertion matches a position in the Validation Rule, not a character. A word boundary is any non-
word character, e.g., a space, newline, or the beginning or ending of a string.

Characters and Abbreviations for Sets of Characters

Element Meaning

c A character represents itself unless it has a special regexp meaning. e.g. ¢
matches the character c.

\c A character that follows a backslash matches the character itself, except as
specified below. e.g., To match a literal caret at the beginning of a string, write
\A,

\a Matches the ASCII bell (BEL, 0x07).

\f Matches the ASCII form feed (FF, 0x0C).

\n Matches the ASCII line feed (LF, 0x0A, Unix newline).

\r Matches the ASCII carriage return (CR, 0x0D).

\t Matches the ASCII horizontal tab (HT, 0x09).

\v Matches the ASCII vertical tab (VT, 0x0B).

\xhhhh Matches the Unicode character corresponding to the hexadecimal number hhhh

(between 0x0000 and OxFFFF).
\Oooo (i.e., \zero matches the ASCIl/Latin1 character for the octal number ooo (between 0 and

000) 0377).

. (dot) Matches any character (including newline).

\d Matches a digit (QChar::isDigit()).

\D Matches a non-digit.

\s Matches a whitespace character (QChar::isSpace()).

\S Matches a non-whitespace character.

\w Matches a word character (QChar::isLetterOrNumber(), QChar::isMark(), or ' ").
\W Matches a non-word character.

\n The n-th backreference, e.g. \1, \2, etc.

E Text Box - The multiline text box is used only if more than one line of input is required and
allows you to input text information. To input a new line the user must press CTRL+Enter. By
pressing only the Enter key will close the text box.

TextBox Properties

Columns |80

Fows |6

oK Cancel

E Columns - Define the number of columns of you text box (max: 128)
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E Rows - Define the number of rows of you text box (max: 128)

™ Value - Defines the object as a numeric value.

E Minimum Value - Defines the minimum value reachable, normally used to countdown.
™ Maximum Value - Defines the maximum value.

™ Step Value - Define step value when updated, use negative value for countdown.

E Decimals - Defines the number of decimal places.

E Alignment - Set horizontal alignment

K Prefix - Defines character set that precedes the number.

E Suffix - Defines character set shown after the number.

K Special Value - Is the value the object will assume after reaching the maximum or minimum
values.

E Integer Value - Allows you to write any integer value in one line box.

Integer Value Properties

Minimum Value b
Maximum Value 999999
Step Value 1

Alignment | Right
Prefix
sufix

Special Value

oK Cancel

™ Maximum Value - Defines the maximum value.

™ Step Value - Define step value when updated, use negative value for countdown.
E Alignment - Set horizontal alignment

™ Prefix - Defines character set that precedes the number.

E Suffix - Defines character set shown after the number.

E Special Value - Is the value the object will assume after reaching the maximum or minimum
values.

E Date - Allows you to write any date value in single line box.
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Date Properties

Minimum Date |1900f01/01

Maximum Date |2100/12/31

Alignment | Left
Calendar popup | Yes

Date format | yyyy/Mm/dd

oK Cancel

Ef Minimum Date - Set the minimum value to date to awoids backdating.
E Maximum Date - Set the maximum value to date to awids introducing later dates.
E Alignment - Allows you to align text date inside object.

Ef Calendar Pop-up - Every time you change settings on date field it pops up a calendar to easy
date manipulation.

Q Fevereiro_| 2011 (5]

dom seg ter gqua qui sex sab
30 3112 3 4 5
6 7 8 9 10 11 12
13 14 15 16 17 18 19
20 21 22 23 24 25 26

27 28 1 2 3 4 5
6 7 ] 9 10 11 12

E Date Format - Helps you set a date value format, you have some predefined.

E Time - Allows you to write any time value in one line box.

Time Properties

Minimum Time |[00:00:00

Maximum Time |23:35:59
Alignment | Left

Time format | hh:mm:ss

oK Cancel

E Minimum Time - Set the minimum value to time to awids backtiming
E Maximum Time - Set the maximum value to date to awoids introducing later time.
E Alignment - Allows you to align time text inside object.

E Time Format - Helps you set a time value format, you have some predefined.
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E Date and Time - Allows you to write any date and time value in one line box.

Date and Time Properties

Minimum Date |1900/01/01
Maximum Date [2100/12/31
Minimum Time |[00:00:00

Maximum Time |23:59:59

Alignment | Left
Calendar popup | No

Date & Time format | yyyy/mMm/dd (hh:mm:ss)

0K Cancel

™ Minimum Date - Set the minimum value to date to awoids backdating.

™ Maximum Date - Set the maximum value to date to awoids introducing later dates.
K Minimum Time - Set the minimum value to time to awids backtiming

E Maximum Time - Set the maximum value to date to awids introducing later time.
E Alignment - Allows you to align text date inside object.

™ Calendar Pop-up - Every time you change settings on date field it pops up a calendar to easy
date manipulation.

Q Fevereiro_| 2011 (5]

dom seg ter gqua qui sex sab
30 31112 3 4 5
6 7 2 9 10 11 12
13 14 15 16 17 138 19
20 21 22 23 24 25 26
27 28 1 2 3 4 5
4] 7 8 9 10 11 12

E Date and Time Format - Helps you set a date and time value format, you havwe some
predefined.

™ List - Allows you to create a list, composed by two columns, the first is an index column and the
second is the data column.
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[ List

Text Line
Text Box
Value
Integer Value
Date

Time

Date and Time

List Text Data E
Database list

™ Database List - Allows you to create a combobox to select the update data to your object. This
only works if connected to a SQL database.

List From database Properties
SOL Select

User column |r_i |

Data Column |1 |

limitrows (a0 2

[ OK HCanceI]

O e SQL Select statement is part of the SQL code and bellow we describe some examples in
how to use that code, specially how to use the select statement.

g

SELECT column_name(s)
FROM table_name

O Lets consider the example bellow, from our internal database, where we select the position,
extension and salary fields, from the employee database. This is the first step, the second is to set
a condition, only consider the records with the field salary with a value lower than 35000.

Now the selection is made and the condition is set.
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List From database Properties
SOL Select

SELECT position, extension, salary
FROM employee
WHERE| salary<35000

User column |0 |

Data Column |1 |

Limit Rows |40 =

[ OK. ,I Cancel |

[ User Column - Here you define what column will be listed on the combo box, as a reference to
the Data Column.

E Data Column - Define to wish column belong the data that will be shown on the database list
object.

E Limit Rows - Setup the maximum rows to be listed on the combo box, to a maximum of 99.

6 After we define the User Column as 0 and the Data Column as 1, we define the column to be

listed as the first (the count starts from zero) and the Data Column as the second and the result will
be as shown bellow.

[ Database list | =
Text Line

LY | ™\
Text Box e \
Value /

Integer Value

Date - \! .
Time List From datab3se Properties
Date and Time

. SQL Select
List Q
Database list

SELECT position, extension, salary
FROM employee
WHERE| salary<35000

User column |0 |

Data Column |1 |

Limit Rows |40 Elv

[ OK. ~_‘,I Cancel |

Please enter text

[ Sales Representative
Sales F&apreﬁentaﬁve
Sales Representative
Mail Clerk

Receptionist

| »

On your combo box is only listed the position field records (User Column 0) that matches the
condition (salary<35000). And when the position Mail Clerk is selected the object assume the
extension field record of the selected position 6261.
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E Font Auto Adjust - Automatically adjust the font size, but only if font point size is auto.

™ Concatenation - Allows you to add a prefix or a suffix to your date and it can be printable, to do
that just check on the check-box.

4.4.10.1.4 4.4.10.1.4 - Database

(i ] There are two ways to add am object linked to a database to the card document. Open a
database and drag and drop the fields like explained further on this manual or create the object and

then connect it to a database. We will address the last option now.

After creating an object go to the Source Tab and select the Database option.

0 After you have chosen this option your tab changes.

Position

Clipping

oz
=
@
E
c

o

=X

Rotation

Outline

[ Source

[ Keyboard Input

Print Counter
Print Date
Keyboard Input
Database

Item Link

| When Item Double-Clicke:

Save with document

|N0

Data Type

| Text Box

Font auto adjust

| MNever

Concatenation

r

| Database

[ Connect to Database ... ]

Font auto adjust

| Never

Concatenation

0 And the next step is too click on the button 'Connect to a Database'. The Database
Connection Wizard will start allowing you to connect to any database you want.

After the database is opened, by default the object will be connected to the first table and first
column of your database, like shown on picture bellow. All you have to do now is define the table and

column that you want your object to be linked to.

K Font Auto Adjust - When you have defined a size for your object it allows you to choose if you

want that cardPresso automatically adjust the font size.
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[ Connect to Database ... | /\ ’

|7J [Never

l Database
5
| Font auto adjust
&
l MNever

Clipping

Source

Mewver

Always
Expand to fit
Shrink to fit

E Concatenation - Allows you to add a prefix or a suffix to your data and print it. While in
datatabase mode you can concatenate up to four columns on the same object and define a prefix

separator if needed.

Data Prefix

Column Prefix

[ ignore on print

[ Ignore on print

Column

'l Employee ID
Column Prehx

Column

| (Not Used)

Column Prefix

Column

(l {Not Used)

[ OK |[Cance||
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P Ble Edt View ol Database Wndow Help
I_ﬂﬁ & OsEaE ABA LE EEEE - -
Eﬂ:“ﬁw;mmmmammlmm

Table Employes
Record 1 of 15

Jial

Sales Fepresertatve |

Barth Date
[1972n2/08 i00:00:00) 12

Hire Diate
|1991/03129 (po:o0:00) 2]

EFBEEBREONI G

Home Phone
120E)555-0857
Extemnsian
[l
' o .-
Zoom Out
m—

As you can see the first element on our object is 'Employee ID' the one connected by default and
the two others we choose to merge in our object, the first and last names.

4.4.10.1.5 4.4.10.1.5 - ltem Link

(i ] This option allows you to connect an object to another, assuming the same values with
automatic update.

| 'ﬁ]
Print Counter
Print Date Item P
Keyboard Input i |
Database
item Link Font auto adjus’t EMPLYEE 1D

1D BARCODE
| Never B 2D BARCODE

Script

MI

When you chose this option your tab changes, allowing you to chose an object to link, showing on
the list all objects that are on the card space and which is possible to connect, in this particular
case we have a card with three other objects.
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0 When connected the object will assume the linked object value and ewery time it is updated so is

our object.

4.4.10.2 - Image & Signature

0 When you select an image object a new tab is added to properties tabs, the Image Tab, where
you will be able to define your image settings. But the source tab also changes, allowing you to

define the source settings of your image file.

| From Disk

[sorce
- !

Title

From Disk

From Camera or Scanner

|Please editimage

| From Signature Pad
From Photo Editor

Source

From Database

| C:/Disk/Projectos/CardPresso/Templ

Item Link

Updated

| When Item Double-Clicked

Save with document

|‘|‘és

Format

| Image Free format

Face Detection

|N0

Open image editor

| Only when error

4.4.10.2.1 4.4.10.2.1 - From Disk

(i ] This option sets the image source as the disk. When the object is updated the browser opens

allowing you to pick an image from disk.

To open an object from disk the procedure is simple, just click on the 'Browse Image’ button, add a
picture object to your card and a window will open allowing you to browse for your file.

Like shown on the picture bellow:
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Ef Title - Here you can give a name/title to your image, it will be easier for you to identify your
object later in further operations.

™ Source - Opens a dropdown list with all cameras or scanners that are installed on your pc or
mac.

Ef Updated - Your object is updated in five different situations:

Fill

T

When Item Double-Clicked

source On Custom View
\ On Edit View
[ From Disk When Load Document
Before Print
Title Before Print Card

After Print Card

|P|ease browse image

source [Image Free format -
[ C:/Disk/Projectos/CardPresso/Tem Image 1x1
Image 3x2
Updated Image 2x3
[when ltem Double-Clicked Image 4x3
Image 640x430
Save with document Image 480x640

Image 800x600
[‘I‘ES Image 600x300
Image 1024x768
Format

Image 768x1024
Image 1920x1080
Image 1080x1920

Imaﬁ Free format

[ Image Free format

Face Detection

o

[Oriywhen error |«

Yes
Mo

Omwhen error

Open image editor

[ Only when error
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E When Item Double-Clicked - When you double-click on top of the object it will open the
interface related to the source you have chosen.

E When Load Document - Every time you open the card document.

E Before Print - Before the printing procedure it will open the interface related to the source you
have chosen.

™ Before Print Card - Before each time a card is printed it will open the interface related to the
source you have chosen.

™ After Print Card - After printing each card it will open the interface related to the source you
have chosen.

™ Save with Document - Save the image with the document so you don't loose any data, but in
the other hand if you don't want to keep the image for a smaller card document just chose 'No'.

™ Format - The image can have a pre-established format, like shown on the image abowe, adapting
the image to it or a free format, allowing you to keep the image source format.

Ef Face Detection - When you chose yes, after the image as been acquired the image editor
opens, allowing you to chose the face detection option.

E Open Image Editor - You can open the editor every time the image is updated (yes), never
open the editor (no) or open the editor only when an error is detected (Only when error).

4.4.10.2.2 4.4.10.2.2 - From Camera or Scanner

O Atter you add an image to your card, the first thing that opens is the image editor, but you can
change your image source any time you want and a camera or scanner is one of your options.
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Fill

Image [ When ltem Double-Clicked | «
| When Item Double-Clicked

_Saurce ) On Custom View
On Edit View
| From Camera or Scanner When LGEI_d Document
Before Print

Before Print Card

Title i
After Print Card

|Please browse image

S
ource [Image Free format -

| TW-Brother DCP-]315W LAN

Image 1x1
Image 3x2
Updated Image 2x3
| When Item Double-Clicked Image 4x3
Image 640x4380
Save with document Image 480x640

Image 800x600
Image 600x300
Image 1024x768
Image 763x1024
Image 1920x1080
Image 1030x1920
Image Free format

|‘|'Es

Format

| Image Free format

Face Detection

|N0

[ Only when error | +

Yes
Mo
Only when error

Open image editor

| Only when error

After chose this option your source pad changes allowing setup the camera or scanner options.

E Title - Here you can give a nameftitle to your image, it will be easier for you to identify your
object later in further operations.

™ Source - Opens a dropdown list with all cameras or scanners that are installed on your pc or
mac.

E Updated - Your object is updated in five different situations:

E When Item Double-Clicked - When you double-click on the object it will open the interface
related to the source you have chosen.

E When Load Document - Every time you open the card document.

E Before Print - Before the printing procedure it will open the interface related to the source you
have chosen.

™ Before Print Card - Before each time a card is printed it will open the interface related to the
source you have chosen.

™ After Print Card - After printing each card it will open the interface related to the source you
have chosen.

E Save with Document - Save the image with the document so you don't loose any data, but in
the other hand if you don't want to keep the image for a smaller card document just chose 'No'.
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™ Format - The image can hawe a pre-established format, like shown on the image abowe, adapting
the image to it or a free format, allowing you to keep the image source format.

™ Face Detection - When you chose yes, after the image as been acquired the image editor
opens, allowing you to chose the face detection option.

Ef Open Image Editor - You can open the editor every time the image is updated (yes), never
open the editor (no) or open the editor only when an error is detected (Only when error).

4.410.2.3 4.4.10.2.3 - From Signature Pad

0 Signature pad is a signature acquisition device, cardPresso work essencial with two kinds, the
Topaz or any device that work with the WinTab drivers.

The acquisition procedure is simple, after click on the 'Signature’ button and add the signature
object to the card a list will pop-up to allow you to chose the device in case of the Topaz, like shown
bellow.

After choosing the device the interface window will show and wait for you to add the signature to the
device like in the pictures bellow:
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TOPAZ WINTAB

The Topaz device also allows you to have templates for the signature frame. The Wintab drive have a
track pressure setting that according with the pressure made by the pen makes the line thinner or
thicker

Like any other image object, cardPresso allows you to use an existing object, all you have to do is
to click on the object and change the source to 'From Signature Pad' and starts the procedure of
signature acquisition.

E Source - Opens a dropdown list with all signature devices that are installed on your computer.

E Updated - Your object is updated in five different situations:

[
Please select your Signatune Device from the list belove

| Topaz Siglite LCD 1x5 Backit

Wpaz Sighemtolers.?

Bpazsglercoles

[Topaz SigLite LCD 1x5 Backhit
W Topaz Sigute LCD 4x3

WPaz SignatureGem LOD 1xS

Topaz SignatureGem LOD 1x5 Backdt I

Topaz SignatureGem LCD 4x3

Tpaz SignatureGem LCD 4x3 (TLBKTSSSE BHSE-R)

RPAT SignatureGaem LD 4x5
Source |

| From Signature Pad A

[ when [tem Double-Clicked v
When Item Double-Clicked

Title

|Please sign here |

| On Custom View -

On Edit View Source

When Load Document

Before Print (“I | Topaz Signature Pad J
Before Print Card

After Print Card Updated

L]

Image Free format | When Item Double-Clicked | - |
Image 1x1 Save with document

Image 3x2

Image 2x3 Yes .
Image 4x3 r‘ | ]
Image 640x480 - Format

Image 430x640 \

Image 800x600 e

Image 600x800 N ,[ iRasalieadommat M
Image 1024x768 "
Image 768x1024

Image 1080x1920

Image Free format

[M When Item Double-Clicked - When you double-click on the object it will open the interface
related to the source you have chosen.
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Ef When Load Document - Every time you open the card document.

™ Before Print - Before the printing procedure it will open the interface related to the source you
have chosen.

Ef Before Print Card - Before each time a card is printed it will open the interface related to the
source you have chosen.

Ef After Print Card - After printing each card it will open the interface related to the source you
have chosen.

Ef Save with Document - Save the signature image with document so you don't loose any data,
but in the other hand if you don't want to keep the image for a smaller card document just chose 'No'.

™ Format - The image can hawe a pre-established format, like shown on the image abowe, adapting
the image to it or a free format, allowing you to keep the image source format.

4.4.10.2.4 4.4.10.2.4 - From Image Editor

(i ] The Image Editor brings you new tools for image edition, there are many ways to open the image
editor, but to acquisition only one, open an image object and then change the source to 'From

i Heaam ARE @

o

HEEEEEEEEEENENS

HEEEEN

536 x 331 - 1E000%

On the tool bar you can set this settings on your image:

Ef Rotate clockwise - Is the circular motion is one that proceeds in the same direction as a
clock's hands: from the top to the right, then down and then to the left, and back up to the top.

™ Rotate anti-clockwise - Is the circular motion is one that proceeds in the opposite direction as
a clock's hands: from the top to the left, then down and then to the right, and back up to the top.

Ef Flip Horizontal - This option reverses the active object horizontally, that is, from left to right. It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central vertical axis of the object.
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™ Flip Vertical - This option reverses the active object ertically, that is, from top to bottom. It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central horizontal axis of the object.

™ Brightness and Contrast - The Brightness/Contrast adjustment lets you make simple
adjustments to the tonal range of an image. Moving the brightness slider to the right increases tonal
values and expands image highlights, to the left decreases values and expands shadows. The
contrast slider expands or shrinks the owerall range of tonal values in the image. To change values
you can drag the slider to the left or to the right or setup manually typing the values on the boxes.
The values can go from -128 to 128.

E Color Balance - Is the global adjustment of the intensities of the colors (typically red, green,
and blue primary colors or RGB system). Changing the owerall mixture of colors in an image and is
used for color correction and when you drag any of the sliders, you can see those corrections taking
place, adjustments are made to the color values RGB (on screen) or CMY (on printers). The values
can go from -128 to 128.

™ Color to Grey - Apply gray scale on the image in which the value of each pixel is a single
sample, that is, it carries only intensity information. Images of this sort, are composed exclusively of
shades of gray, varying from black at the weakest intensity to white at the strongest.

E Color to Monochrome - Not a combine black and white in a continuum producing a range of
shades of gray but really starkly contrasted black and white.

E Zoom In - This tool allows you to obtain a larger image, or a closer view.
E Zoom Out - This tool allows you to obtain a smaller image, or a farther view.
E Zoom Auto - Reset image to its initial size.

™ Export Image - You can sawe the image as... in many different formats like png, jpg, bmp, tiff
and others.

™ Select Image Acquisition Source - Allows you to select the image acquisition source from
any device that is connected or installed on your pc. It may appear some devices that are not
connected but are installed.

E Image Acquisition - This tools opens the interface related with the image acquisition source
you had chosen.

™ Open Image File - Opens an image file from your system, including disk, pen, memory card or
any other source.

K Select Image File Path - Allows you to chose your default image file path from all that you had
already used before on your document.

E Face Detection
E Face Detection Setup

E Undo - It erases the last change done to the document reverting it to an older state.
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Ef Clear Image - Erases the image from Image Editor.

™ cut / Crop - On cardPresso crop tool you don't use the traditional handlers, the visual area is
automatically resized to the image object boundaries, to cut/crop the image all you hawe to do is to
drag or zoom in on the image and every thing that is on the blur area (gray and black squares) when
you click the cut/crop button, goes away. And the image is automatically adjusted to the object
area.

Ef Save Changes - Click on this button to accept the changes.
Ef Cancel - Click on this button to quit on the changes.
4.4.10.2.5 4.4.10.2.5 - From Database

6 cardPresso allows you to connect an image object to a database image, this way you can
setup the object as you want and then connect to the database image adapting it to your object.

The procedure is simple, first add a image object to your card change the source to 'From
Database’.

0 If not connected to a database yet o click on the 'Connect to Database"' button.

Dfeer
sudect the database driver that dertiies your databane comeson.

candPresss nbemal Database (msAccess)
Derect C5W 6 T e Diwvar
Corect Exrel fila Orrver

SOL0e versan 3

Durect Azcaus Fls Drivee

Open Database Comnectvity (00BC)
Open Databavs Comnctrty (00BC ane)
ML Drtvee

. i )

. The connection wizard will start

6 After connection is made, if there is none image field, the link is not made and the list stays like
the image bellow, empty.

If there is only one image field, the cardPresso recognize it and the link is automatic.

O i more then one then a list will show you the options for you to chose, like shown
bellow.
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| ) |« [ ¢ [ ™ [ N [ o | » [ o | & | sT
[Phete cardiD Image

Rui Faria F200r5435 Ch\Users\PublichPictures\Sample Pictures\Penguins.jpg

Jodo Lucas 32448035  C\Users\Public\Pictures\Sample Pictures\Koala.jpg

Daniel Gomes B2EDTF3S Ch\Users\PublichPictures\Sample Pictures\Jellyfish.jpg

Nunao Marting F20Mr9435

Carlos Pinheirg 32048035

|

DATABASE

Source |

| From Database

Table
| Employee
Column
| Photo [@Photo =
Save with decument | @Fhoto
@mage
| Mo

Face Detection

|N0

Open image editor

| Only when error

cardPresso

0 If, in the meanwhile, you add a field image, please don't forget to refresh the database.
4.410.2.6 4.4.10.2.6 - ltem Link

(i ] This option allows you to connect (link) one object to another object, assuming the same data
values with automatic update.

When you choose this option your tab changes allowing you to chose an object to link, showing on
the list all objects that are on the card document that you can connect to,

Q For the next sample we will use an image object.
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[ Item Link | v]

|

ITEM 162B3FAC

6 When connected, the object will assume the linked object value and every time it is updated also
the first object will also reflect the data from the linked object.

This option allows you to have two image objects, one at the from of te card and another at the back
of the card, sharing the same data.

4.4.11 - Alignment

6 The alignment tab allows you to define the object alignment inside the boundaries

[Alig nment ]I

Select your item alignment

0 3 N 3

Rotation

Your Text
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As you can see you can define vertically from top, middle or bottom and horizontally from left, middle
or right.

When the point size is in auto, on the font tab, it means that the font size justify the text to the
boundaries what makes the horizontal adjustment very small

0 The default position is left and middle.

4.4.12 - Script

O There are two different scripts on cardPresso, one for each object and one for the document. In
this chapter we focus on the object script

This is an advanced user area, where you can program actions and procedures in javascript
language in order to define settings or update your object.

[Scr‘ipt |

|- When ltem Double-Clicked | 4

When tem Double-Clicked
On Custom View

On Edit View

when Load Document
Before Print

Before Print Card

After Print Card

Record changed

Script | Output @

A

T This first drop-menu allow you to define when this actions or procedures must take place, if
when you click on the object, when open Edit View, when load a document, before or after printing.

. And on the space bellow you can write your lines of code.

. To see the log of your program output, change tab bellow.

4.4.13 - Multi Align

O The mutti align tab is only displayed when three or more objects are selected and is divided in
two classes, the alignment between objects and the distribution.
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[Multi—Align |

( Alignment Between Objects |

E Alignment Between Objects - This one aligns vertically and horizontally the objects to top,
middle or bottom and to left, middle or right using as boundaries the card limits.

™ Distribution - Is a bit more complex, allows you to distribute the objects on the card area
equitably, but instead of using the card limits as a reference uses the object boundaries referring to
the last object selected that is marked with blue selection handles.

All other objects will be allocated according to the selection and having as a reference the last one
selected, notice that the reference object is also the anchor and will not move, all the others will be
placed according with the distribution settings.

In short, the space occupied by the three or more objects will always be the same, the space
between them is the one that will be arrange.

4.5 - Edit View

6 This chapter will explain you what the Edit View is about, its basic concept, features, availability
and objective.

Imagine that you have a small business, with eight or ten employees and you want to keep a record
for each and even print a card for time attendance or access allowance
And then you think... but | don’t now how to work with a database.

0 Basically Edit View is a very simple, small but powerful alternative to a database,
where you can keep until ten records, and manipulate them as you wish.

6 The Edit View is available from our basic edition, the XXS, allowing you to have a first contact
with cardPresso capability of database manipulation and if you don't need more than ten records or
don’t know how to work with a database, then the Edit View may become your ideal solution.
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All the records are saved into you card document file, so there are no attached files or any other files
to look after and you can use an existing card template or create a new one.

Edit View also allows editing any kind of field type that you can find on any other database, text,
date, numbers and also allows you to add and edit images of any kind.

Ok after the presentation we took a cardTemplate like the one on the picture below:

fourLogo

amhltects

= fé/remy Hardens

Englneer Supervisor

As you can see we have three workable objects, the name, the position and the photo.

Q Click on the name, for example and then on the source tab on the Update option chose 'On Edit
View'
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CF Fe Edt wiew ol Database Wndow Help

=8

H A4 architects

Yourlogo.

Updatid
[ on Edit view -

‘When Rem Double-Clicked
On Custam View

Sav

‘When Load Document
Dt Bedare Print
Eofare Prink Card
|After Print Card

EFBREEBR-Oml B

© Then a new tab is available, the Edit View tab.

Edit View
@ Nasee o=
0000 0

1 of 1 history records

Photo

architects

YourlLogo

eremy Hardens' Q

" Engineer Supernsor @h

Name

|Jeremy Hardens |

Position

|Engineer Supervisor |

Very similar to the database tab, with the command buttons on the top and already with our name
field.
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'.' Go to the first record

. Go to the last record

'.' Go to the next record

'.' Go to the previous record
. Delete displayed record

. Add a new record

(i ] To star lets give names to our objects, like Name, Position and Photo, it will be easier in the
future to identify them.

To add the other objects to the Edit View the process is the same, select the object, go to the
source tab and on the Update option chose 'On Edit View".

Now we have all three objects on the Edit View, to order them as you like just drag and drop on the
tab.

Edit View |

a « > O =
M N N N

1 of 1 histery records

Photo

Name - \
|leremy Hardens |
Name EE:'J.'rH-:
Jeremy Hardens ﬁ
Position

|Engineer Supervisor |

Database

oAII you have to do now is add more records, filling the fields on the 'Edit View' tab, until a
maximum of 64 records (on XXS Edition only 10).
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